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Notas, avisos y precauciones
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 AVISO: Un AVISO indica la posibilidad de daños en el hardware 
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 PRECAUCIÓN: Una PRECAUCIÓN indica un posible daño 
material, lesión corporal o muerte.

Abreviaturas y siglas
Para obtener una lista completa de las abreviaturas y las siglas, 
consulte el apartado “Glosario” en la página 137.
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Antes de comenzar

Información relacionada

La tabla siguiente le lleva a la información que está buscando en el 
dispositivo relevante y la documentación del ordenador.

¿Qué busca? Encuéntrelo aquí:

Cómo configurar el dispositivo e 
información en los accesorios, 
conectores y botones del dispositivo

El diagrama de configuración de colocación 
y el Manual del propietario de Dell™.

Información sobre el uso del 
dispositivo

Manual del propietario de Dell y Ayuda de 
Pocket PC.

NOTA: Para ver la Ayuda, puntee en Inicio y 
luego en Ayuda.

Otros programas que pueden 
instalarse en el dispositivo

CD de inicio de Dell

Información sobre el uso de 
programas en el dispositivo

Ayuda de Pocket PC y, si está disponible, 
puntee en Ayuda de un programa específico

Conexión y sincronización con 
un ordenador

Manual del propietario de Dell y Ayuda de 
Microsoft®ActiveSync® en el ordenador.

Para ver la ayuda, inicie MS ActiveSync, haga 
clic en Help→ Microsoft ActiveSync Help 
(Ayuda→ Ayuda de Microsoft ActiveSync).

NOTA: Para obtener más ayuda de 
ActiveSync:

http://www.microsoft.com/windowsmobile/
help/activesync/default.mspx

Actualizaciones más recientes e 
información técnica detallada

Archivos “readme”, ubicados en la carpeta 
ActiveSync del ordenador y en el CD de 
inicio de Dell.

Información actualizada sobre el 
Pocket PC

www.microsoft.com/windowsmobile

y

support.dell.com

Mi etiqueta de servicio y/o Express 
Service Code (código de servicio 
rápido)

La etiqueta se encuentra en la ranura de la 
batería debajo de la batería (retire la 
batería).

Product Key Ubicado en la etiqueta del COA (certificado 
de autenticidad) en el CD de inicio.
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Cómo ponerse en contacto con Dell
Para ponerse en contacto con Dell de forma electrónica, puede acceder a 
los siguientes sitios web:

• www.dell.com

• support.dell.com (asistencia)

Para obtener las direcciones web de su país, busque la sección 
correspondiente en la siguiente tabla. 

 NOTA: Los números de teléfono gratuitos son para uso dentro del país para el 
que aparecen.

 NOTA: En algunos países, la asistencia específica para los ordenadores 
portátiles Dell XPS™ está disponible en un número de teléfono diferente que 
aparece en la lista de países participantes. Si no ve en la lista ningún número 
de teléfono específico de los ordenadores portátiles XPS, puede ponerse en 
contacto con Dell a través del número de asistencia que aparece en la lista y su 
llamada se redirigirá al departamento correspondiente.

Cuando necesite ponerse en contacto con Dell, utilice las direcciones 
electrónicas, los números de teléfono y los códigos que se incluyen en la 
siguiente tabla. Si necesita ayuda para averiguar los códigos que debe utilizar, 
póngase en contacto con un operador de telefonía local o internacional. 
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País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos

Alemania (Langen)

Código de acceso 
internacional: 00

Código de país: 49

Código de ciudad: 
6103

Sitio web: support.euro.dell.com

Correo electrónico: 
tech_support_central_europe@dell.co
m

Asistencia técnica sólo para 
ordenadores portátiles XPS

06103 766-7222

Asistencia técnica para todos los 
demás ordenadores Dell

06103 766-7200

Atención al cliente para particulares 
y pequeñas empresas

0180-5-224400

Atención al cliente para cuentas 
globales

06103 766-9570

Atención al cliente para cuentas 
preferentes

06103 766-9420

Atención al cliente para grandes 
cuentas

06103 766-9560

Atención al cliente para cuentas 
públicas

06103 766-9555

Central telefónica 06103 766-7000

Anguila Asistencia general gratuito:
800-335-0031

Antigua y Barbuda Asistencia general 1-800-805-5924

Antillas Holandesas Asistencia general 001-800-882-1519
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Argentina 
(Buenos Aires)

Código de acceso 
internacional: 00

Código de país: 54

Código de ciudad: 
11

Sitio web: www.dell.com.ar

Correo electrónico: 
us_latin_services@dell.com

Correo electrónico para ordenadores 
portátiles y de sobremesa: 
la-techsupport@dell.com 

Correo electrónico para servidores y 
productos de almacenamiento 
EMC®:
la_enterprise@dell.com

Atención al cliente  gratuito:
0-800-444-0730

Asistencia técnica gratuito:
0-800-444-0733

Servicios de asistencia técnica gratuito:
0-800-444-0724

Ventas 0-810-444-3355

Aruba Asistencia general gratuito: 800-1578

Australia (Sydney)

Código de acceso 
internacional: 0011

Código de país: 61

Código de ciudad: 2

Sitio web: support.ap.dell.com

Correo electrónico: 
support.ap.dell.com/contactus

Asistencia general 13DELL-133355

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Austria (Viena)

Código de acceso 
internacional: 900

Código de país: 43

Código de ciudad: 1

Sitio web: support.euro.dell.com

Correo electrónico: 
tech_support_central_europe@
dell.com

Ventas a particulares y pequeñas 
empresas

0820 240 530 00

Fax para particulares y pequeñas 
empresas

0820 240 530 49

Atención al cliente para particulares 
y pequeñas empresas

0820 240 530 14

Atención al cliente para cuentas 
preferentes y corporaciones

0820 240 530 16

Asistencia sólo para ordenadores 
portátiles XPS

0820 240 530 81

Asistencia para particulares y 
pequeñas empresas para todos los 
demás ordenadores Dell

0820 240 530 14

Asistencia para cuentas preferentes y 
corporaciones

0660 8779

Central telefónica 0820 240 530 00

Bahamas Asistencia general gratuito:
1-866-278-6818

Barbados Asistencia general 1-800-534-3066

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
Antes de comenzar 13



Bélgica (Bruselas)

Código de acceso 
internacional: 00

Código de país: 32

Código de ciudad: 2

Sitio web: support.euro.dell.com

Asistencia técnica sólo para 
ordenadores portátiles XPS

02 481 92 96

Asistencia técnica para el resto de 
ordenadores Dell

02 481 92 88

Fax de asistencia técnica 02 481 92 95

Atención al cliente 02 713 15 65

Ventas corporativas 02 481 91 00

Fax 02 481 92 99

Central telefónica 02 481 91 00

Bermuda Asistencia general 1-800-342-0671

Bolivia Asistencia general gratuito:
800-10-0238

Brasil

Código de acceso 
internacional: 00

Código de país: 55

Código de ciudad: 
51

Sitio web: www.dell.com/br

Servicio al cliente, asistencia técnica

0800 90 3355

Fax de asistencia técnica  51 481 5470

Fax de atención al cliente  51 481 5480

Ventas 0800 90 3390

Brunei

Código de país: 673

Asistencia técnica (Penang, Malasia) 604 633 4966

Atención al cliente (Penang, Malasia) 604 633 4888

Ventas de transacciones (Penang, 
Malasia)

604 633 4955

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Canadá (North 
York, Ontario)

Código de acceso 
internacional: 011

Estado de pedidos en línea: 
www.dell.ca/ostatus

AutoTech (asistencia de garantía y 
hardware automatizada)

gratuito:
1-800-247-9362

Servicio al cliente (Ventas a 
particulares/Pequeña empresa)

gratuito:
1-800-847-4096

Servicio al cliente (empresas 
medianas y grandes, y del gobierno)

gratuito:
1-800-326-9463

Servicio al cliente (impresoras, 
proyectores, televisores, dispositivos 
de bolsillo, jukebox digital y 
dispositivos inalámbricos)

gratuito:
1-800-847-4096

Asistencia de garantía de hardware 
(Ventas a particulares/Pequeña 
empresa)

gratuito:
1-800-906-3355

Asistencia de garantía de hardware 
(empresas medianas y grandes, y del 
gobierno)

gratuito:
1-800-387-5757

Asistencia de garantía de hardware 
(impresoras, proyectores, televisores, 
dispositivos de bolsillo, jukebox 
digital y dispositivos inalámbricos)

1-877-335-5767

Ventas (particulares y pequeñas 
empresas)

gratuito:
1-800-387-5752

Ventas (pequeñas y medianas 
empresas, instituciones 
gubernamentales)

gratuito:
1-800-387-5755

Ventas de repuestos y por extensión 
de servicio

1866 440 3355

Chile (Santiago)

Código de país: 56

Código de ciudad: 2

Ventas y servicio al cliente gratuito:
1230-020-4823

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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China (Xiamén)

Código de país: 86

Código de ciudad: 
592

Sitio web de asistencia técnica: 
support.dell.com.cn

Correo electrónico de asistencia 
técnica: cn_support@dell.com

Correo electrónico de atención al 
cliente: customer_cn@dell.com

Fax de asistencia técnica 592 818 1350

Asistencia técnica (Dell™ 
Dimension™ e Inspiron)

gratuito:
800 858 2968

Asistencia técnica (OptiPlex™, 
Latitude™ y Dell Precision™)

gratuito:
800858 0950

Asistencia técnica (servidores y 
almacenamiento)

gratuito:
800858 0960

Asistencia técnica (proyectores, PDA, 
conmutadores, enrutadores y otros)

gratuito:
800 858 2920

Asistencia técnica (impresoras) gratuito:
800 858 2311

Atención al cliente gratuito:
800 858 2060

Fax de atención al cliente 592 818 1308

Particulares y pequeñas empresas gratuito:
800 858 2222

División de cuentas preferentes gratuito:
800 858 2557

Grandes cuentas corporativas GPC gratuito:
800 858 2055

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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China (Xiamén)

Código de país: 86

Código de ciudad: 
592

(continuación)

Grandes cuentas corporativas y 
cuentas principales

gratuito:
800 858 2628

Grandes cuentas corporativas del 
norte

gratuito:
800 858 2999

Grandes cuentas corporativas del 
norte y del ámbito educativo

gratuito:
800 858 2955

Grandes cuentas corporativas del 
este 

gratuito:
800 858 2020

Grandes cuentas corporativas del 
este y del ámbito educativo

gratuito:
800 858 2669

Grandes cuentas corporativas del 
grupo de cola

gratuito:
800 858 2572

Grandes cuentas corporativas del sur gratuito:
800 858 2355

Grandes cuentas corporativas del 
oeste

gratuito:
800 858 2811

Grandes cuentas corporativas de 
diferentes partes 

gratuito:
800 858 2621

Colombia Asistencia general 980-9-15-3978

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
Antes de comenzar 17



Corea (Seúl)

Código de acceso 
internacional: 001

Código de país: 82

Código de ciudad: 2

Correo electrónico: 
krsupport@dell.com

Asistencia gratuito:
080-200-3800

Asistencia (Dimension, PDA, 
componentes electrónicos y 
accesorios)

gratuito:
080-200-3801

Ventas gratuito:
080-200-3600

Fax 2194-6202

Central telefónica 2194-6000

Costa Rica Asistencia general 0800-012-0435

Dinamarca 
(Copenhague)

Código de acceso 
internacional: 00

Código de país: 45 

Sitio web: support.euro.dell.com

Asistencia técnica sólo para 
ordenadores portátiles XPS

7010 0074

Asistencia técnica para todos los 
demás ordenadores Dell

7023 0182

Atención al cliente (relacional) 7023 0184

Atención al cliente para particulares 
y pequeñas empresas

3287 5505

Central telefónica (relacional) 3287 1200

Fax de la central telefónica 
(relacional)

3287 1201

Central telefónica (particulares y 
pequeñas empresas)

3287 5000

Fax de la central telefónica 
(particulares y pequeñas empresas)

3287 5001

Dominica Asistencia general gratuito:
1-866-278-6821

Ecuador Asistencia general gratuito: 999-119

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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EE.UU. 
(Austin, Texas)

Código de acceso 
internacional: 011

Código de país: 1

Servicio automatizado para averiguar 
el estado de un pedido

gratuito:
1-800-433-9014

AutoTech (para ordenadores 
portátiles y de escritorio)

gratuito:
1-800-247-9362

Asistencia de garantía y hardware 
(proyectores, impresoras y TV de 
Dell) para clientes pertenecientes al 
servicio de relaciones con Dell

gratuito
1-877-459-7298

Asistencia de XPS para los 
consumidores de América

gratuito:
1-800-232-8544

Consumidor (particulares y oficinas 
domiciliarias) Asistencia para el resto 
de productos Dell

gratuito:
1-800-624-9896

Atención al cliente gratuito:
1-800-624-9897

Clientes del programa de compra 
para empleados (EPP [Employee 
Purchase Program])

gratuito:
1-800-695-8133

Sitio web de servicios financieros:
www.dellfinancialservices.com

Servicios financieros (alquiler y 
préstamos)

gratuito:
1-877-577-3355

Servicios financieros (cuentas 
preferentes de Dell [DPA, Dell 
Preferred Accounts])

gratuito:
1-800-283-2210

Empresa 

Servicio al cliente y asistencia gratuito:
1-800-456-3355

Clientes del programa de compra 
para empleados (EPP [Employee 
Purchase Program])

gratuito:
1-800-695-8133

Asistencia para impresoras, 
proyectores, PDA y reproductores de 
MP3

gratuito:
1-877-459-7298

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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EE.UU. 
(Austin, Texas)

Código de acceso 
internacional: 011

Código de país: 1

(continuación)

Público (instituciones 
gubernamentales, 
educativas y sanitarias)

Servicio al cliente y asistencia gratuito:
1-800-456-3355

Clientes del programa de compra 
para empleados (EPP [Employee 
Purchase Program])

gratuito:
1-800-695-8133

Ventas de Dell gratuito:
1-800-289-3355

 o gratuito:
1-800-879-3355

Dell Outlet Store (ordenadores Dell 
restaurados)

gratuito:
1-888-798-7561

Venta de software y periféricos gratuito:
1-800-671-3355

Venta de piezas de repuesto gratuito: 1-800-357-
3355

Venta de servicios y garantías 
ampliados

gratuito:
1-800-247-4618

Fax gratuito:
1-800-727-8320

Servicios de Dell para personas 
sordas, con discapacidades auditivas 
o del habla

gratuito:
1-877-DELLTTY

(1-877-335-5889)

El Salvador Asistencia general 01-899-753-0777

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Eslovaquia (Praga)

Código de acceso 
internacional: 00

Código de país: 421

Sitio web: support.euro.dell.com

Correo electrónico: 
czech_dell@dell.com

Asistencia técnica 02  5441 5727

Atención al cliente 420  22537 2707

Fax 02  5441 8328

Fax de asistencia técnica 02  5441 8328

Central telefónica (ventas) 02  5441 7585

España (Madrid)

Código de acceso 
internacional: 00

Código de país: 34

Código de ciudad: 
91

Sitio web: support.euro.dell.com

Particulares y pequeñas empresas

Asistencia técnica 902 100 130

Atención al cliente 902 118 540

Ventas 902 118 541

Central telefónica 902 118 541

Fax 902 118 539

Corporativa

Asistencia técnica 902 100 130

Atención al cliente 902 115 236

Central telefónica 91 722 92 00

Fax 91 722 95 83

Finlandia 
(Helsinki)

Código de acceso 
internacional: 990

Código de país: 358

Código de ciudad: 9

Sitio web: support.euro.dell.com

Asistencia técnica 09 253 313 60

Atención al cliente 09 253 313 38

Fax 09 253 313 99

Central telefónica 09 253 313 00

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Francia (París) 
(Montpellier)

Código de acceso 
internacional: 00

Código de país: 33

Códigos de ciudad: 
(1) (4)

Sitio web: support.euro.dell.com

Particulares y pequeñas empresas

Asistencia técnica sólo para 
ordenadores portátiles XPS

0825 387 129

Asistencia técnica para todos los 
demás ordenadores Dell

0825 387 270

Atención al cliente 0825 823 833

Central telefónica 0825 004 700

Central telefónica (llamadas desde 
fuera de Francia)

04 99 75 40 00

Ventas 0825 004 700

Fax 0825 004 701

Fax (llamadas desde fuera de 
Francia)

0499754001

Corporativa

Asistencia técnica 0825 004 719

Atención al cliente 0825 338 339

Central telefónica 01 55 94 71 00

Ventas 01 55 94 71 00

Fax 01 55 94 71 01

Granada Asistencia general gratuito:
1-866-540-3355

Grecia

Código de acceso 
internacional: 00

Código de país: 30

Sitio web: support.euro.dell.com

Asistencia técnica 00800-44 14 95 18

Asistencia técnica Gold Service 00800-44 14 00 83

Central telefónica 2108129810

Central telefónica para Gold Service 2108129811

Ventas 2108129800

Fax 2108129812

Guatemala Asistencia general 1-800-999-0136

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Guayana Asistencia general gratuito:
1-877-270-4609

Hong Kong

Código de acceso 
internacional: 001

Código de país: 852

Sitio web: support.ap.dell.com

Correo electrónico de asistencia 
técnica: HK_support@Dell.com

Asistencia técnica (Dimension e 
Inspiron)

2969 3188

Asistencia técnica (OptiPlex, 
Latitude y Dell Precision)

2969 3191

Asistencia técnica (PowerApp™, 
PowerEdge™, PowerConnect™ y 
PowerVault™)

2969 3196

Atención al cliente 3416 0910

Cuentas corporativas grandes 3416 0907

Programas globales para clientes 3416 0908

División de la mediana empresa 3416 0912

División de la pequeña empresa y la 
particular

2969 3105

India Correo electrónico: 
india_support_desktop@dell.com
india_support_notebook@dell.com
india_support_Server@dell.com

Asistencia técnica 1600338045

y 1600448046

Ventas (Grandes cuentas 
corporativas)

1600 33 8044

Ventas (Particulares y Pequeña 
empresa)

1600 33 8046

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Irlanda 
(Cherrywood)

Código de acceso 
internacional: 00

Código de país: 353

Código de ciudad: 1

Sitio web: support.euro.dell.com

Correo electrónico: 
dell_direct_support@dell.com

Asistencia técnica sólo para 
ordenadores portátiles XPS 

1850 200 722

Asistencia técnica para todos los 
demás ordenadores Dell

1850 543 543

Asistencia técnica en el Reino Unido 
(sólo para llamadas dentro del Reino 
Unido)

0870 908 0800

Atención al cliente (particulares) 01 204 4014

Atención al cliente para pequeñas 
empresas

01 204 4014

Atención al cliente en el Reino 
Unido (sólo para llamadas dentro del 
Reino Unido)

0870 906 0010

Atención al cliente para 
corporaciones

1850 200 982

Atención al cliente en el Reino 
Unido (sólo para llamadas dentro del 
Reino Unido)

0870 907 4499

Ventas para Irlanda 01 204 4444

Ventas en el Reino Unido (sólo para 
llamadas dentro del Reino Unido)

0870 907 4000

Fax/Fax de ventas 01 204 0103

Central telefónica 01 204 4444

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Italia (Milán)

Código de acceso 
internacional: 00

Código de país: 39

Código de ciudad: 
02

Sitio web: support.euro.dell.com

Particulares y pequeñas empresas

Asistencia técnica 02 577 826 90

Atención al cliente 02 696 821 14

Fax 02 696 821 13

Central telefónica 02 696 821 12

Corporativa

Asistencia técnica 02 577 826 90

Atención al cliente 02 577 825 55

Fax 02 575 035 30

Central telefónica 02 577 821

Islas Caimán Asistencia general 1-800-805-7541

Islas Turks y Caicos Asistencia general gratuito:
1-866-540-3355

Islas Vírgenes 
Americanas

Asistencia general 1-877-673-3355

Islas Vírgenes 
Británicas

Asistencia general gratuito:
1-866-278-6820

Jamaica Asistencia general 
(sólo para dentro de Jamaica)

1-800-682-3639

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Japón (Kawasaki)

Código de acceso 
internacional: 001

Código de país: 81

Código de ciudad: 
44

Sitio web: support.jp.dell.com

Asistencia técnica (servidores) gratuito:
0120-198-498

Asistencia técnica fuera de Japón 
(servidores)

81-44-556-4162

Asistencia técnica 
(Dimension e Inspiron)

gratuito:
0120-198-226

Asistencia técnica fuera de Japón 
(Dimension e Inspiron)

81-44-520-1435

Asistencia técnica (Dell Precision, 
OptiPlex y Latitude)

gratuito:
0120-198-433

Asistencia técnica fuera de Japón 
(Dell Precision, OptiPlex y Latitude)

81-44-556-3894

Asistencia técnica (PDA, proyectores, 
impresoras, enrutadores)

gratuito:
0120-981-690

Asistencia técnica fuera de Japón 
(PDA, proyectores, impresoras, 
enrutadores)

81-44-556-3468

Servicio Faxbox 044-556-3490

Servicio de pedidos automatizado las 
24 horas del día

044-556-3801

Atención al cliente 044-556-4240

División de ventas corporativas 
(hasta 400 empleados)

044-556-1465

Ventas de la división de cuentas 
preferentes (más de 400 empleados)

044-556-3433

Ventas de grandes cuentas 
corporativas (más de 3.500 
empleados)

044-556-3430

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Japón (Kawasaki)

Código de acceso 
internacional: 001

Código de país: 81

Código de ciudad: 
44

(continuación)

Ventas al sector público (agencias del 
Estado, instituciones educativas y 
médicas)

044-556-1469

Cuentas globales de Japón 044-556-3469

Usuario individual 044-556-1760

Central telefónica 044-556-4300

Latinoamérica Asistencia técnica al cliente (Austin, 
Texas, EE.UU.)

512 728-4093

Atención al cliente (Austin, Texas, 
EE.UU.)

512 728-3619

Fax (Asistencia técnica y Servicio al 
cliente) (Austin, Texas, EE.UU.)

512 728-3883

Ventas (Austin, Texas, EE.UU.) 512 728-4397

Fax de ventas (Austin, Texas, 
EE.UU.)

512 728-4600

ó 512 728-3772

Luxemburgo

Código de acceso 
internacional: 00

Código de país: 352

Sitio web: support.euro.dell.com

Asistencia 342 08 08 075

Ventas a particulares y pequeñas 
empresas

+32 (0)2 713 15 96

Ventas corporativas 26 25 77 81

Atención al cliente +32 (0)2 481 91 19

Fax 26 25 77 82

Macao

Código de país: 853

Asistencia técnica gratuito: 0800 105

Servicio al cliente (Xiamén, China) 34 160 910

Ventas de transacción (Xiamén, 
China)

29 693 115

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Malasia (Penang)

Código de acceso 
internacional: 00

Código de país: 60

Código de ciudad: 4

Sitio web: support.ap.dell.com

Asistencia técnica (Dell Precision, 
OptiPlex y Latitude)

gratuito:
1 800 880 193

Asistencia técnica (Dimension, 
Inspiron, y componentes electrónicos 
y accesorios)

gratuito:
1 800 881 306

Asistencia técnica (PowerApp, 
PowerEdge, PowerConnect y 
PowerVault) 

gratuito:
1800 881 386

Atención al cliente gratuito: 1800 881 3
06 (opción 6)

Ventas de transacciones gratuito:
1 800 888 202

Ventas corporativas gratuito:
1 800 888 213

México

Código de acceso 
internacional: 00

Código de país: 52

Asistencia técnica al cliente 001-877-384-8979

ó 001-877-269-3383

Ventas 50-81-8800

ó 01-800-888-3355

Atención al cliente 001-877-384-8979

ó 001-877-269-3383

Main (Principal) 50-81-8800

ó 01-800-888-3355

Montserrat Asistencia general gratuito:
1-866-278-6822

Nicaragua Asistencia general 001-800-220-1006

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Noruega (Lysaker)

Código de acceso 
internacional: 00

Código de país: 47

Sitio web: support.euro.dell.com

Asistencia técnica sólo para 
ordenadores portátiles XPS

815 35 043

Asistencia técnica para todos los 
demás productos Dell

671 16882

Atención relacional al cliente 671 17575

Atención al cliente para particulares 
y pequeñas empresas

23162298

Central telefónica 671 16800

Central telefónica de fax 671 16865

Nueva Zelanda

Código de acceso 
internacional: 00

Código de país: 64

Sitio web: support.ap.dell.com

Correo electrónico: 
support.ap.dell.com/contactus 

Asistencia general 0800 441 567

Países Bajos 
(Amsterdam)

Código de acceso 
internacional: 00

Código de país: 31

Código de ciudad: 
20

Sitio web: support.euro.dell.com 

Asistencia técnica sólo para 
ordenadores portátiles XPS

020 674 45 94

Asistencia técnica para todos los 
demás ordenadores Dell

020 674 45 00

Fax de asistencia técnica 020 674 47 66

Atención al cliente para particulares 
y pequeñas empresas

020 674 42 00

Atención relacional al cliente  020 674 4325

Ventas a particulares y pequeñas 
empresas

020 674 55 00

Ventas relacionales 020 674 50 00

Ventas por fax a particulares y 
pequeñas empresas

020 674 47 75

Fax para ventas relacionales 020 674 47 50

Central telefónica 020 674 50 00

Fax de la central telefónica 020 674 47 50

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
Antes de comenzar 29



Países del sureste 
asiático y del 
Pacífico

Asistencia técnica, servicio al cliente 
y ventas (Penang, Malasia)

604 633 4810

Panamá Asistencia general 001-800-507-0962

Perú Asistencia general 0800-50-669

Polonia (Varsovia)

Código de acceso 
internacional: 011

Código de país: 48

Código de ciudad: 
22

Sitio web: support.euro.dell.com

Correo electrónico: 
pl_support_tech@dell.com

Teléfono de atención al cliente 57 95 700

Atención al cliente 57 95 999

Ventas 57 95 999

Fax de atención al cliente 57 95 806

Fax de la recepción 57 95 998

Central telefónica 57 95 999

Portugal

Código de acceso 
internacional: 00

Código de país: 351

Sitio web: support.euro.dell.com

Asistencia técnica 707200149

Atención al cliente 800 300413

Ventas 800 300 410,
800 300 411,
800 300 412 o
21 422 07 10

Fax 21 424 01 12

Puerto Rico Asistencia general 1-800-805-7545

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Reino Unido 
(Bracknell)

Código de acceso 
internacional: 00

Código de país: 44

Código de ciudad: 
1344

Sitio web: support.euro.dell.com

Sitio web de atención al cliente: 
support.euro.dell.com/uk/en/ECare/Form/Home.asp

Correo electrónico: 
dell_direct_support@dell.com

Asistencia técnica (cuentas 
preferentes, corporativas o PAD, para 
más de 1000 empleados)

0870 908 0500

Asistencia técnica sólo para 
ordenadores portátiles XPS

0870 366 4180

Asistencia técnica (directa y general) 
para el resto de productos

0870 908 0800

Atención al cliente para cuentas 
globales

01344 373 186

Atención al cliente para particulares 
y pequeñas empresas 

0870 906 0010

Atención al cliente para 
corporaciones

01344 373 185

Atención a clientes con cuentas 
preferenciales (500–5.000 
empleados)

0870 906 0010

Atención al cliente para el gobierno 
central

01344 373 193

Atención al cliente para el gobierno 
local y la educación

01344 373 199

Atención al cliente para temas de 
salud

01344 373 194

Ventas a particulares y pequeñas 
empresas

0870 907 4000

Ventas corporativas y al sector 
público

01344 860 456

Fax para particulares y pequeñas 
empresas

0870 907 4006

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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República Checa 
(Praga)

Código de acceso 
internacional: 00

Código de país: 420

Sitio web: support.euro.dell.com

Correo electrónico: 
czech_dell@dell.com

Asistencia técnica 22537 2727

Atención al cliente 22537 2707

Fax 22537 2714

Fax de asistencia técnica 22537 2728

Central telefónica 22537 2711

República 
Dominicana

Asistencia general 1-800-148-0530

Singapur 
(Singapur)

Código de acceso 
internacional: 005

Código de país: 65

Sitio web: support.ap.dell.com

Asistencia técnica (Dimension, 
Inspiron, y componentes electrónicos 
y accesorios)

gratuito:
1800 394 7430

Asistencia técnica (OptiPlex, 
Latitude y Dell Precision)

gratuito:
1800 394 7488

Asistencia técnica (PowerApp, 
PowerEdge, PowerConnect y 
PowerVault)

gratuito:
1800 394 7478

Atención al cliente gratuito:
1 800 394 7430

(opción 6)

Ventas de transacciones gratuito:
1 800 394 7412

Ventas corporativas gratuito:
1 800 394 7419

St. Kitts y Nevis Asistencia general gratuito:
1-877-441-4731

St. Lucia Asistencia general 1-800-882-1521

St. Vicente y las 
Granadinas

Asistencia general gratuito:
1-877-270-4609

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Sudáfrica 
(Johannesburgo)

Código de acceso 
internacional:

09/091

Código de país: 27

Código de ciudad: 
11

Sitio web: support.euro.dell.com

Correo electrónico: 
dell_za_support@dell.com

Gold Queue 011 709 7713

Asistencia técnica 011 709 7710

Atención al cliente 011 709 7707

Ventas 011 709 7700

Fax 011 706 0495

Central telefónica 011 709 7700

Suecia (Upplands 
Vasby)

Código de acceso 
internacional: 00

Código de país: 46

Código de ciudad: 8

Sitio web: support.euro.dell.com

Asistencia técnica sólo para 
ordenadores portátiles XPS

0771 340 340

Asistencia técnica para todos los 
demás productos Dell

08 590 05 199

Atención relacional al cliente 08 590 05 642

Atención al cliente para particulares 
y pequeñas empresas

08 587 70 527

Soporte para el programa de compra 
para empleados (EPP [Employee 
Purchase Program])

20 140 14 44

Fax de asistencia técnica 08 590 05 594

Ventas 08 590 05 185

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Suiza (Ginebra)

Código de acceso 
internacional: 00

Código de país: 41

Código de ciudad: 
22

Sitio web: support.euro.dell.com

Correo electrónico: 
Tech_support_central_Europe@dell.
com

Asistencia técnica sólo para 
ordenadores portátiles XPS

0848 33 88 57

Asistencia técnica (particulares y 
pequeñas empresas) para el resto de 
productos Dell

0844 811 411

Asistencia técnica (corporaciones) 0844 822 844

Atención al cliente para particulares 
y pequeñas empresas

0848 802 202

Atención al cliente para 
corporaciones

0848 821 721

Fax 022 799 01 90

Central telefónica 022 799 01 01

Tailandia

Código de acceso 
internacional: 001

Código de país: 66

Sitio web: support.ap.dell.com

Asistencia técnica (OptiPlex, 
Latitude y Dell Precision)

gratuito:
1800 0060 07

Asistencia técnica (PowerApp, 
PowerEdge, PowerConnect y 
PowerVault)

gratuito:
1800 0600 09

Atención al cliente gratuito:
1800 006 007

(opción 7)

Ventas corporativas gratuito:
1800 006 009

Ventas de transacciones gratuito:
1800 006 006

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Taiwán

Código de acceso 
internacional: 002

Código de país: 886

Sitio web: support.ap.dell.com

Correo electrónico: 
ap_support@dell.com

Asistencia técnica (OptiPlex, 
Latitude, Inspiron, Dimension, y 
componentes electrónicos y 
accesorios)

gratuito:
00801 86 1011

Asistencia técnica (PowerApp, 
PowerEdge, PowerConnect y 
PowerVault)

gratuito:
00801 60 1256

Atención al cliente gratuito:
00801 60 1250

(opción 5)

Ventas de transacciones gratuito:
00801 65 1228

Ventas corporativas gratuito:
00801 651 227

Trinidad y Tobago Asistencia general 1-800-805-8035

Uruguay Asistencia general gratuito:
000-413-598-2521

Venezuela Asistencia general 8001-3605

País (Ciudad)
Código del país 
Código de acceso 
internacional
Código de la ciudad

Nombre del departamento o área de 
servicio,

sitio web y dirección de correo 
electrónico

Códigos de área,
números locales y

números de teléfono
gratuitos
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Para empezar
Dell Axim X51 y Dell Axim X51v son los PDA (Asistente Digital Personal) 
más nuevos de Dell. Axim X51 hace referencia a las configuraciones baja y 
media, mientras que Axim X51v hace referencia a la configuración alta 
compatible con VGA. Consulte la tabla para ver los “Accesorios” en la 
página 37. Los modelos Axim X51/X51v ofrecen: 

• Tecnología inalámbrica integrada (sólo para las configuraciones media y 
alta)

• Pantallas QVGA y VGA 
• Tamaño y pesos reducidos 

• Salida VGA en el modelo Axim X51v 

Desembalaje del dispositivo
El PDA Axim está equipado con accesorios estándar y con algunos elementos 
extra en función del modelo que haya adquirido. El embalaje del dispositivo 
contiene información importante como, por ejemplo, la Product Key en la 
cubierta del CD de inicio y el número de pedido en el albarán de entrega. 
Anote estos datos para usarlos más adelante. 

Cuando desembale el dispositivo por primera vez, compruebe que incluye la 
siguiente lista de  elementos. Si encuentra a faltar alguno, póngase en 
contacto con el departamento de soporte técnico de Dell. Consulte el 
apartado “Cómo ponerse en contacto con Dell” en la página 10.

Accesorios

Contenido Alta Media Baja

Axim X51 624 MHz, 
inalámbrica, 
Bluetooth

520 MHz, 
inalámbrica, 
Bluetooth

416 MHz, 
Bluetooth

Base Estándar Estándar Opcional

Cable de sincronización USB Opcional Opcional Estándar

Conector del adaptador Estándar Estándar Estándar

Portaestuche estándar Estándar Estándar Estándar
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Opcional: se tiene que ordenar aparte

Consulte la siguiente ilustración para ver los accesorios estándar y opcionales.

Manual del propietario de 
Dell

Estándar Estándar Estándar

CD de inicio de Dell Estándar Estándar Estándar

Adaptador de CA y cable de 
alimentación

Estándar Estándar Estándar

Batería estándar (1100 mAh) Estándar Estándar Estándar

Batería de alta capacidad 
(2200 mAh)

Opcional Opcional Opcional

Protector de pantalla Opcional Opcional Opcional

Accesorios

Contenido Alta Media Baja

Pantalla táctil

Portaestuche

Base

CD de inicio 
de Dell

Manual del propietario de Dell

Cable de 
alimentación

Adaptador de CA

Cable de 
sincronización

Conector del 
adaptador

Batería
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Vistas anterior, lateral y posterior

 PRECAUCIÓN: Antes de realizar cualquiera de los procedimientos que se 
especifican en este apartado, lea las siguientes instrucciones de seguridad 
de la Guía de información del producto.

Vistas anterior y lateral

SENSOR  DE  INFRARROJOS :  Transfiere archivos del dispositivo a otro dispositivo 
compatible con infrarrojos sin necesidad de utilizar conexiones de cables.

M ICRÓFONO :  Se utiliza para grabar sonido.

TARJETA  COMPACTFLASH  Y  RANURAS  PARA  TARJETAS  DE  MEMORIA  SECURE  
D IG ITAL :  Consulte el apartado “Utilización de tarjetas” en la página 51 para 
obtener información sobre cómo utilizar tarjetas CompactFlash y tarjetas de 
memoria Secure Digital.

Tarjeta CompactFlash y 
ranuras para tarjetas de 
memoria Secure Digital 
(parte superior)

Botón de 
alimentación

Pantalla 
táctil

Botón de navegación

Botón Inicio

Botón de contactos

Botón de calendario

Gancho de 
sujeción

Micrófono

Botón de bandeja 
de entrada

Conector de audio (parte superior)

Indicador 
luminoso 
inalámbrico

Sensor de infrarrojos (superior)

Botón de 
bloqueo

Botón de 
encendido/
apagado para 
la tecnología 
inalámbrica 
WLAN/
Bluetooth®

Botón de 
grabación

Lengüeta 
protectora 
de mylar
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BOTÓN  DE  AL IMENTACIÓN :  Presione el botón de alimentación para encender o 
apagar el dispositivo. Presione y mantenga presionado el botón de alimentación 
para atenuar la pantalla. Presione y mantenga presionado de nuevo el botón para 
iluminar la pantalla. Utilice la ficha de botón de alimentación para configurar el 
botón de encendido de modo que apague el dispositivo completamente. De esta 
forma, se ahorrará batería.

PANTALLA  TÁCT IL :  Introduzca información a través de la pantalla táctil mediante 
un lápiz. Consulte el apartado “Introducción de información” en la página 65. 

PROTECTOR  DE  PANTALLA :  Utilice protectores de pantalla para proteger la 
pantalla táctil del dispositivo. Debe ir cambiando los protectores con el tiempo 
para alargar la vida de la pantalla táctil.

BOTÓN  DE  ENCENDIDO /APAGADO  PARA  LA  TECNOLOGÍA  INALÁMBRICA  

WLAN/BLUETOOTH
® :  En los dispositivos inalámbricos, el botón enciende y 

apaga tanto la tecnología inalámbrica WLAN como Bluetooth. Puntee sobre él dos 
veces para confirmar el apagado o encendido de WLAN/ Bluetooth. Apague los 
dispositivos inalámbricos para conservar energía. En los dispositivos Bluetooth, el 
botón sirve para activar y desactivar la tecnología inalámbrica Bluetooth.

BOTÓN  INIC IO :  Presione para abrir la ventana Home (Página principal) o para 
encender el dispositivo.

BOTÓN  DE  NAVEGACIÓN :  Presione el extremo derecho, izquierdo, superior o 
inferior del botón de navegación para mover el cursor por la pantalla. Haga clic en 
el botón del centro para introducir una selección.

BOTÓN  CONTACTOS :  Presione este botón para abrir la aplicación Contactos o para 
encender el dispositivo.

BOTÓN  CALENDARIO :  Presione este botón para abrir la aplicación Calendario o 
para encender el dispositivo.

BOTÓN  GRABACIÓN :  Para obtener información sobre cómo utilizar el botón de 
grabación, consulte el apartado “Grabación de un mensaje” en la página 73.

BOTÓN  DE  BLOQUEO :  Utilice este botón para bloquear el dispositivo y su pantalla 
táctil, de modo que el dispositivo no responda si se presionan las teclas 
accidentalmente.

Estado actual de la 
tecnología inalámbrica

Conmutador Estado nuevo de la tecnología 
inalámbrica

WLAN Bluetooth WLAN Bluetooth

Desactivado Desactivado Activado Activado

Activado Desactivado Desactivado Desactivado

Desactivado Activado Desactivado Desactivado

Activado Activado Desactivado Desactivado
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Vista posterior

SEGURO  DE  LA  BATER ÍA :  Utilice este interruptor para liberar y extraer la batería 
principal. Consulte el apartado “Instalación y extracción de la batería” en la 
página 42.

BATER ÍA :  Para obtener información sobre la batería principal, consulte el 
apartado “Utilización de la batería” en la página 42.

CONECTOR  DEL  CABLE  DE  SINCRONIZAC IÓN /BASE :  Conecte un cable de 
sincronización/base. Consulte el apartado “Conexión a un ordenador” en la 
página 48.

BOTÓN  DE  RESTABLEC IMIENTO :  Para obtener información sobre cómo utilizar el 
botón de restablecimiento, consulte el apartado “Restablecimiento del PDA Axim” 
en la página 53.

LÁPIZ :  Utilice el lápiz para escribir o dibujar en la pantalla. Para extraer el lápiz, 
tire de él hacia arriba y sáquelo del compartimento. Para evitar la pérdida del lápiz, 
guárdelo en el compartimento cuando no lo esté utilizando. Asegúrese de que el 
lápiz esté orientado correctamente cuando vuelva a colocarlo en la ranura.

Lápiz (extraído)

Batería 
(interior)

Seguro de la 
batería en 
posición de 
bloqueo

Conector del cable de 
sincronización/base (inferior)

Botón de 
restablecimiento
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Utilización de la batería
El dispositivo se envía con una batería estándar de 1100 mAh 
(miliamperios/hora), cuya autonomía mínima estimada es de 5 a 8 horas. 
También se puede adquirir una batería de mayor capacidad (2200 mAh). 
La batería de 2200 mAh tiene una autonomía mínima estimada de 10 a 16 
horas. 

 AVISO: No utilice el dispositivo hasta que haya cargado la batería principal por 
lo menos durante 8 horas como mínimo en la primera carga. 

Antes de utilizar el dispositivo por primera vez, deberá cargar la batería. 
Presione el botón de alimentación para encender el dispositivo. Cuando la 
batería se haya cargado, podrá encender el dispositivo siguiendo las 
instrucciones en el sistema operativo para visualizar la pantalla Today 
(Hoy). Observe el indicador luminoso del botón de encendido para 
supervisar la carga de la batería. Consulte la Ayuda de Pocket PC en el 
dispositivo, para obtener más información. 

Instalación y extracción de la batería

Para instalar la batería:

1 Compruebe que el dispositivo esté apagado.

2 Desbloquee el seguro de la batería y retire la cubierta de la misma.

3 Alinee los contactos de la batería con los contactos de la ranura de la 
batería, inserte  la batería y encájela en la ranura.

Batería
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4 Cierre la cubierta de la batería.

5 Bloquee la cubierta de la batería deslizando el seguro de la batería hacia 
la derecha.

Para extraer la batería:

1 Deslice el seguro de la batería hacia la izquierda para desbloquear la 
cubierta de la batería.

2 Levante la cubierta de la batería.

Cubierta de la batería

Seguro de 
la batería 
en posición
de bloqueo

Cubierta de la batería

Seguro 
de la batería 
desbloqueado
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3 Empuje la lengüeta para sacar la batería de la ranura.

 NOTA: La etiqueta de servicio se encuentra debajo de la batería, en la 
ranura para la batería. Esta etiqueta de servicio es necesaria para 
acceder al sitio web de soporte de Dell en support.dell.com o para llamar 
al servicio de atención al cliente o al soporte técnico de Dell. El Express 
Service Code de Dell también se encuentra aquí.

Carga de la batería

Debe cargar la batería antes de utilizarla por primera vez. A continuación, 
recargue la batería cada vez que se agote (el indicador luminoso del botón 
de encendido parpadeará en ámbar).
Utilice una de las opciones siguientes para cargar la batería principal:
• Conecte el adaptador de CA al adaptador del cargador y, a 

continuación, conecte el adaptador del cargador al dispositivo.
• Conecte el adaptador de CA al cable de sincronización y, a 

continuación, conecte el cable de sincronización al dispositivo. 
Consulte el apartado “Utilización del cable” en la página 50.

• Conecte el adaptador de CA a la base e inserte el dispositivo en la 
misma. Consulte el apartado “Utilización de la base” en la página 48 
para obtener más información.

El paquete de batería estándar (1100 mAh) se carga completamente en 5 
horas; el paquete de la batería más potente (2200 mAh) tarda 10 horas en 
cargarse totalmente.

Batería

Lengüeta de tiro
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Si la batería principal está prácticamente agotada, el dispositivo entra en 
modo de suspensión y el dispositivo se apaga. 

Para recuperar una batería que está prácticamente agotada: 

1 Conecte el adaptador de CA o cambie la batería principal por una 
batería que esté cargada. 

2 Presione el botón de alimentación para encender el dispositivo. 

De manera predeterminada, el dispositivo se apaga si no se utiliza durante 
un período de tiempo determinado. Este modo recibe el nombre de 
“modo de suspensión”. Para obtener información sobre cómo establecer el 
tiempo durante el cual el dispositivo puede permanecer inactivo antes de 
apagarse, consulte el apartado “Ficha Sistema” en la página 75. 

Si desea ahorrar batería, puede apagar el PDA Axim sin perder datos. Los 
datos se almacenan en el ROM Flash y, por lo tanto, no se pierden cuando 
el dispositivo se apaga.

Uso del dispositivo Axim
Cuando encienda el dispositivo, aparecerá la pantalla Today (Hoy). 
También puede ver la pantalla Hoy punteando en el botón Inicio y, a 
continuación, en Hoy. En la pantalla Hoy se muestra la fecha e 
información acerca del propietario del dispositivo, el calendario de hoy y 
las tareas importantes. Para personalizar la pantalla Hoy:

1 Puntee en Inicio→ Configuración.

2 Puntee en la ficha Personal→ Today (Hoy).

Utilice la ficha Appearance (Apariencia) para cambiar el fondo de la 
pantalla Today (Hoy).

Utilice la ficha Items (Elementos) para cambiar los elementos que 
aparecen en la pantalla Hoy. 
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Cambio del modo de pantalla en el dispositivo 

Los dispositivos Axim X51/X51v con el software Microsoft® Windows 
Mobile™ Versión 5.0 para Pocket PC Premium Edition pueden mostrar la 
pantalla tanto de forma horizontal como vertical. 

Para cambiar el modo de pantalla de horizontal a vertical:

1 Puntee en Inicio→ Configuración. 

2 En la ventana Configuración, puntee en Sistema→ Pantalla. 

3 En la ventana Pantalla, puntee en Vertical para seleccionar el modo 
vertical.

 NOTA: Para cambiar el modo de pantalla de vertical a horizontal, puntee 
en Horizontal.

4 Puntee en Aceptar y cierre la ventana. 

Botón 
Inicio

Icono del 
estado de la 
conexión para 
la tecnología 
inalámbrica 
Bluetooth®

Icono de control 
del volumenIcono de conexión
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Funcionamiento de Axim

Utilización del botón de alimentación
Presione el botón de alimentación para encender o apagar el dispositivo. 
Presione y mantenga presionado el botón  de alimentación para atenuar la 
pantalla. Éste es el modo de ahorro de energía. Presione y mantenga 
presionado de nuevo el botón para iluminar la pantalla. Utilice la ficha 
Power Button (Botón de encendido) para configurar el botón de 
alimentación de modo que apague el dispositivo completamente. De esta 
forma, se ahorrará batería.
• Cuando el dispositivo está conectado a una alimentación externa y la 

batería principal está completamente cargada, el indicador luminoso del 
botón de alimentación es verde continua.

• Cuando la carga de la batería principal está baja, el indicador luminoso del 
botón de alimentación parpadea en color ámbar.

• Cuando la batería se está cargando, el indicador luminoso del botón de 
alimentación es ámbar continua. 

• Cuando el dispositivo transmite una notificación, la luz del botón de 
alimentación en seguida parpadea en verde.

 NOTA: Cuando una batería tiene muy poca carga, la configuración de fecha y 
hora se conserva durante 168 horas. Esta configuración se puede mantener 
durante 5 minutos cuando no llega ningún tipo de alimentación al dispositivo 
(adaptador de CA o batería principal). Cuando el PDA Axim se queda sin batería 
durante más de 5 minutos, la configuración de fecha y hora se pierde. Sin 
embargo, los datos almacenados en el ROM Flash se quedan guardados.

Utilización del lápiz
Su dispositivo está equipado con un lápiz para seleccionar elementos e 
introducir información. En el dispositivo, el lápiz realiza la función del ratón:

• Puntear: toque la pantalla una vez con el lápiz para abrir elementos y 
seleccionar opciones.

• Arrastrar: mantenga el lápiz en la pantalla y deslícelo por la pantalla para 
seleccionar texto e imágenes. Deslice el lápiz por una lista para 
seleccionar varios elementos.
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• Puntear y mantener: puntee y mantenga presionado el lápiz en un 
elemento para ver una lista de las acciones disponibles. En el menú 
emergente que aparece, puntee en la acción que desee realizar.

Consulte el apartado “Introducción de información” en la página 65 para 
obtener más información.

Conexión a un ordenador
Asimismo, puede conectar el dispositivo a un ordenador mediante una 
base o directamente a un ordenador mediante un cable de sincronización. 
Conecte el dispositivo a un ordenador para:
• Agregar programas al dispositivo. Para obtener más información, 

consulte el apartado “Adición de programas con Microsoft® 
ActiveSync®” en la página 109.

• Sincronizar los datos del dispositivo con los datos del ordenador.

Para obtener más información sobre cómo sincronizar datos, consulte los 
recursos siguientes:

• La Ayuda de ActiveSync en el ordenador

• La Ayuda de ActiveSync en el dispositivo

Utilización de la base

 NOTA: Según la configuración del dispositivo, la base puede ser opcional. 

Puede utilizar la base para:
• Sincronizar los datos del dispositivo con los datos del ordenador. 
• Conecte el dispositivo a una toma de alimentación eléctrica para 

conservar la alimentación de la batería.
• Cargar la batería principal. Consulte el apartado “Utilización de la 

batería” en la página 42 para obtener más  información.
• Cargar una batería de repuesto. Tenga en cuenta que la batería de 

repuesto es opcional.

 NOTA: Antes de conectar el dispositivo a un ordenador por primera vez, 
instale  ActiveSync en el ordenador mediante el CD de inicio de Dell™. 

Para conectar el dispositivo a la base:
1 Conecte el adaptador de CA a la base y a una toma de corriente eléctrica.
2 Coloque el PDA Axim en la base de acoplamiento, cerca del ordenador.
3 Conecte el cable de sincronización USB a la base y al ordenador.
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Cable de 
alimentación

Adaptador de CA

Cable de la base

Conector USB en el ordenador

Base

Base

Indicador luminoso del estado 
de la batería de repuesto
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Cuando el dispositivo esté acoplado a la base, el botón de alimentación 
del dispositivo se encenderá y aparecerá el icono del estado de conexión en 
la barra de comandos (consúltelo en la página 56).

 NOTA: El botón de alimentación del dispositivo indica el estado de carga de la 
batería principal. Consulte la descripción de las luces del botón de 
alimentación en la página 47 para obtener más información.

El indicador de estado de la batería de repuesto que se encuentra en la 
base funciona de la manera siguiente:

• Verde: la batería de repuesto está completamente cargada.

• Ámbar: la batería de repuesto se está cargando.

Para extraer el dispositivo de la base, tire del dispositivo hacia arriba para 
sacarlo de la base.

Utilización del cable 

Utilice el cable de sincronización para conectar el dispositivo 
directamente al ordenador sin utilizar la base.

 NOTA: El cable de sincronización es opcional en función de la configuración del 
dispositivo.

Para conectar el cable de sincronización:

1 Conecte el conector del cable de sincronización al dispositivo. 
Asegúrese de que el logotipo de Dell  esté orientado hacia arriba.

2 Conecte el conector USB del cable al conector USB de su  ordenador. 

 AVISO: Para evitar dañar el conector del cable de sincronización, presione los 
dos botones de los laterales del conector para soltar el seguro antes de 
insertar o extraer el conector. 
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Conexión a un proyector
Puede conectar el dispositivo a un proyector utilizando el cable VGA. 

 NOTA: La opción VGA está disponible sólo con el modelo Axim X51v. El cable  
VGA no se enviará con el dispositivo a no ser que lo solicite.

 NOTA: Para que el dispositivo detecte el proyector, es necesario instalar el 
programa Viewer (Visor) del CD de inicio de Dell. Para configurar el programa, 
consulte el apartado Ayuda en el programa.

Para conectar el dispositivo al proyector, conecte el conector de 
sincronización en el cable VGA al dispositivo y, a continuación, conecte el 
otro conector del cable VGA al cable del proyector. Ejecute el programa 
Viewer para que el dispositivo detecte el proyector.

Utilización de tarjetas
El dispositivo dispone de dos ranuras ubicadas en la parte superior de la 
unidad. La ranura más grande es compatible con tarjetas CompactFlash 
Tipo II. La ranura más pequeña es compatible con tarjetas de memoria 
Secure Digital (SD), tarjetas Secure Digital I/O (SDIO) y las tarjetas 
MultiMediaCard (MMC). Los tres tipos de tarjetas de memoria están 
disponibles en tamaños que van de 64 MB a 1 GB o 2 GB. 

Cable de 
alimentación

Adaptador de CA

Cable de sincronización

Conector USB 
en el ordenador

Conector del dispositivo

Conector del cable 
de sincronización
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Tarjetas CompactFlash 

El dispositivo admite tarjetas CompactFlash de tipo II. Los tipos de 
tarjeta más comunes son los siguientes:

• Módem: conecte una línea telefónica para establecer la comunicación 
de datos por módem.

• Comunicación inalámbrica: establezca la comunicación de datos sin 
utilizar conexiones de cables. Puede utilizar tarjetas, como tarjetas 
internas con tecnología inalámbrica Bluetooth y LAN inalámbrica 
802.11b.

• Almacenamiento: puede guardar datos o instalar programas en una 
tarjeta de almacenamiento.

Cuando no tenga una tarjeta CompactFlash instalada, inserte el panel 
protector de plástico para proteger la ranura para tarjeta CompactFlash.

Para instalar una tarjeta CompactFlash:

1 Si hay un panel protector instalado, quítelo.

2 Alinee la lengüeta en la parte posterior de la tarjeta CompactFlash con 
la muesca en la ranura para tarjetas CompactFlash y deslice la tarjeta 
hacia adentro de la ranura.

 AVISO: No fuerce la tarjeta. Si nota cierta resistencia, extráigala, compruebe 
que la orientación sea la adecuada y vuelva a insertarla.

Consulte la documentación que se incluye con la tarjeta para obtener más 
información.

Panel 
protector

Muesca en la 
ranura para 
tarjetas 
CompactFlash
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Tarjeta de memoria Secure Digital

Utilice las tarjetas de memoria Secure Digital para guardar datos o realizar 
copias de seguridad de los mismos.

Para instalar una tarjeta de memoria Secure Digital:

1 Si ya hay instalada una tarjeta o una tapa de plástico, presiónelas hacia 
adentro para liberarlas y, a continuación, extráigalas.

2 Compruebe que la tarjeta esté orientada correctamente y deslícela por 
la ranura hasta que oiga un “clic”.

 AVISO: No fuerce la tarjeta. Si nota cierta resistencia, extráigala, compruebe 
que la orientación sea la adecuada y vuelva a insertarla.

Consulte la documentación que se incluye con la tarjeta para obtener más 
información.

Restablecimiento del PDA Axim

Restablecimiento ordenado

Cuando lleve a cabo un restablecimiento ordenado, el dispositivo 
suprimirá cualquier dato o programa activo que no se haya guardado en la 
memoria flash; es decir, los archivos y programas guardados no se 
suprimirán. Intente llevar a cabo un restablecimiento ordenado si el 
dispositivo no responde al puntear en la pantalla o presionar un botón. 
El restablecimiento ordenado se desactiva cuando Axim está en modo 
apagado completo.

Panel protector
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Si desea realizar un restablecimiento ordenado, utilice el lápiz para 
presionar el botón de restablecimiento.

Restablecimiento forzado

 AVISO: Cuando realice un restablecimiento forzado, perderá todos los datos 
almacenados en la memoria Flash del dispositivo y cualquier programa que 
haya instalado en el dispositivo.

Realice un restablecimiento forzado si:

• Desea restaurar la configuración predeterminada de fábrica del 
dispositivo.

• Ha olvidado la contraseña y necesita restablecerla.

• El dispositivo está experimentando problemas de funcionamiento 
graves, y ya ha intentado un restablecimiento ordenado.

 AVISO: Se recomienda encarecidamente hacer una copia de seguridad de los 
datos antes de llevar a cabo un restablecimiento forzado.

Lápiz 

Botón de 
restablecimiento
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Para realizar un restablecimiento forzado:

1 Pulse el botón de alimentación para encender la unidad Axim.

2 Pulse y mantenga pulsado el botón de alimentación mientras usa el 
lápiz para pulsar el botón de restablecimiento al mismo tiempo.

3 Suelte el botón de alimentación y el botón de restablecimiento.

Aparece la pantalla To clear all data in the memory (Para borrar todos 
los datos de la memoria).

4 Pulse el botón Contacts (Contactos) del dispositivo Axim para 
suprimir todos los datos de la memoria del dispositivo de bolsillo Axim.

5 Pulse el botón Mail (Correo) del dispositivo Axim para cancelar la 
operación sin perder datos.

Botón de 
alimentación

Botón de contactos

Botón de 
restablecimiento

Botón de correo
Funcionamiento de Axim 55



Utilización del software Microsoft® Windows 
Mobile™ Versión 5.0 para Pocket PC 
Premium Edition Mobile 5.0
El sistema operativo Windows Mobile 5.0 se incluye con un sistema 
principal de nuevas funciones y mejoras en la interfaz. La vista de la pantalla 
y la superficie táctil son parecidas a las de Windows™ XP para ordenadores. 
La RAM se utiliza sólo para ejecutar aplicaciones. La Flash ROM está 
ubicada donde se almacenan todas las aplicaciones, datos PIM y archivos. 
Para obtener información detallada, visite el sitio web www.microsoft.com.

Iconos de estado
 NOTA: Si no hay suficiente espacio para visualizar todos los iconos de 

notificación en el dispositivo, puntee en el icono  para ver la lista oculta de 
iconos.

Icono Descripción

Nuevo correo electrónico o mensaje de 
texto (SMS) 

Nuevo mensaje instantáneo

Nivel de la batería

Batería baja

Carga de la batería

Sin batería

Error de sincronización

Silencio

Bluetooth
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Programas
Puede pasar de un programa a otro seleccionando un programa en el menú 
Inicio. Para acceder a programas que no aparecen en la lista del menú Inicio, 
puntee en Inicio→ Programas y, a continuación, en el nombre del programa.

 NOTA: Algunos programas muestran etiquetas abreviadas para las casillas de 
verificación y menús desplegables. Para ver la etiqueta sin abreviar, puntee y 
mantenga el lápiz en la etiqueta. Arrastre el lápiz lejos de la etiqueta para que 
no se ejecute el comando.

Botones de programa

También puede pasar a algunos programas presionando un botón de 
programa. El dispositivo incluye cuatro botones de programas situados en 
la parte frontal. Los iconos de los botones identifican los programas que 
inician. De forma predeterminada, los botones inician las aplicaciones 
Home, Mensajería, Contactos y Calendario.

Wi-Fi activada

Llamada de datos Wi-Fi

Icono de ayuda

Icono Descripción
Funcionamiento de Axim 57



Barra del conmutador

Asimismo, puede utilizar la barra del conmutador para cambiar de un 
programa a otro o para cerrar los programas abiertos. Para iniciar la barra 
del conmutador o Switcher Bar:

1 Puntee en Inicio→ Configuración.

2 Puntee en System→ Switcher Bar (Sistema→ Barra del conmutador).

El icono de Switcher Bar  aparecerá en la barra de navegación.

Puntee en  para ver una lista de todos los programas abiertos. En 
el menú de Switcher Bar:
• Puntee en las opciones de configuración de Brightness (Brillo) o de 

Power (Alimentación) para realizar los ajustes necesarios.

• Puntee en un nombre de programa para pasar a dicho programa.

• Puntee en Cerrar el programa actual para salir del programa en el 
que se encuentra.

• Puntee en Cerrar todos los programas para salir de todos los 
programas abiertos.

• Puntee en Cerrar Switcher Bar para cerrar el menú.

En la tabla siguiente se muestra una lista parcial de los programas 
instalados en el dispositivo. Consulte el CD de inicio de Dell™ para ver los 
programas adicionales que puede instalar en el dispositivo.

Icono Programa Descripción

ActiveSync Sincroniza la información entre el 
dispositivo y el ordenador.

Calendario Realiza un seguimiento de las citas y crea 
convocatorias de reunión.

Contactos Mantiene una lista de los amigos y colegas.

Mensajería Envía y recibe mensajes de correo 
electrónico.

Internet Explorer 
Mobile

Navega por sitios web y WAP, y descarga 
nuevos programas y archivos de Internet.
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Barra de navegación y barra de comandos
La barra de navegación se encuentra en la parte superior de la pantalla. 
Muestra el programa activo y la hora actual, y permite cambiar a otros 
programas o cerrar pantallas. 

La barra de comandos se encuentra en la parte inferior de la pantalla, y 
sirve para realizar tareas dentro de los programas. La barra de comandos 
incluye nombres de menú, iconos y el icono del panel de entrada. Para 
crear un elemento nuevo en el programa actual, puntee en Nuevo. Para ver 
el nombre de un icono, puntee y mantenga el lápiz en el icono. Arrastre el 
lápiz lejos del icono para que no se ejecute el comando.

Notas Crea notas escritas a mano o tecleadas, 
dibujos o grabaciones.

Tareas Realiza un seguimiento de las tareas.

Excel Mobile Crea libros nuevos, o muestra y edita libros 
de Excel creados en el ordenador.

Pocket MSN Envía y recibe mensajes instantáneos a sus 
contactos de MSN Messenger.

Word Mobile Crea documentos nuevos, o muestra y 
edita documentos de Word creados en el 
ordenador.

PowerPoint Mobile Muestra diapositivas de presentación de 
PowerPoint.

Icono Programa Descripción
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Menús emergentes
Los menús emergentes permiten seleccionar rápidamente una acción para 
un elemento. Por ejemplo, puede utilizar el menú emergente en la lista de 
contactos para suprimir un contacto, realizar una copia o enviar un mensaje 
de correo electrónico a un contacto. Las acciones de los menús emergentes 
varían de un programa a otro. Para acceder a un menú emergente, puntee y 
mantenga el lápiz en el nombre de un elemento. Cuando aparezca el menú, 
levante el lápiz y puntee en la acción que desea realizar. Para cerrar el menú 
sin realizar una acción, puntee en cualquier parte fuera del menú.

Barra de 
navegación

Menú Inicio

Barra de comandos
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Búsqueda de información
La función de búsqueda en el dispositivo ayuda a localizar información 
rápidamente. 

Para buscar archivos u otros elementos:

1 Puntee en Inicio→ Programas→ Search (Búsqueda). 

2 En Search for (Buscar) escriba el nombre del archivo, palabra u otra 
información que desee. 
Si ha buscado este elemento anteriormente, puntee en la flecha Search 
for (Buscar) para seleccionar el elemento de la lista. 

3 En Type (Tipo), seleccione un tipo de datos para delimitar la búsqueda. 

4 Puntee en Search (Búsqueda)
La búsqueda se realizará en la carpeta Mis documentos y las 
subcarpetas. 

5 En la lista Results (Resultados), puntee en el elemento que desee abrir. 

Agregar 
tarea nueva
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Asimismo, puede utilizar el Explorador de archivos para encontrar 
archivos en el dispositivo y organizar los archivos en carpetas. En el menú 
Inicio, puntee en Programa→ Explorador de archivos.

Copia de seguridad de los datos
Para prevenir o minimizar la pérdida de datos, debe realizar periódicamente 
una copia de seguridad de los datos almacenados en el dispositivo. Utilice 
ActiveSync para sincronizar los archivos del dispositivo con los archivos del 
ordenador. También puede arrastrar archivos desde el dispositivo y soltarlos 
en el ordenador mediante el Explorador de Windows. Para obtener más 
información, consulte la Ayuda de ActiveSync en el ordenador. Consulte el 
apartado “Instalación y uso de ActiveSync” en la página 80.

Utilice ActiveSync para crear archivos de copia de seguridad y almacenar 
los archivos en el ordenador host. Para obtener más información sobre los 
dos métodos para realizar copias de seguridad de los archivos, consulte los 
apartados “Copia de seguridad y sincronización de los datos” en la 
página 63 y “Copia de seguridad manual mediante el arrastre de archivos” 
en la página 63.

Menú para 
ordenar

Ubicación de 
la carpeta
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Copia de seguridad y sincronización de los 
datos
El proceso de sincronización compara los datos del dispositivo Axim con los 
datos del ordenador host y los actualiza con los datos más recientes. 
ActiveSync no sincroniza automáticamente todos los tipos de datos. La 
sincronización sólo realiza copias de seguridad de los tipos de datos 
seleccionados en la configuración Opciones. Las opciones se seleccionan 
primero cuando se establece una asociación estándar y se pueden cambiar en 
cualquier momento haciendo clic en el icono Opciones de la ventana 
Microsoft ActiveSync. ActiveSync creará automáticamente una carpeta en el 
ordenador host, en la carpeta Mis documentos llamada Pocket_PC My 
Documents (Mis documentos de Pocket_PC). También crea un acceso directo 
en el escritorio del ordenador host para guardar los datos sincronizados.

Los dos tipos de sincronización son:

Sincronización automática: se realizan copias de seguridad de los datos 
automáticamente cuando se activa ActiveSync mediante el acoplamiento 
y en los intervalos establecidos.

Sincronización manual: si la función de sincronización automática está 
desactivada, puede realizar copias de seguridad de los archivos en 
cualquier momento utilizando el botón Sync (Sincronizar) para iniciar el 
proceso de sincronización.

Para iniciar la sincronización manual:

1 Conecte el dispositivo Axim al ordenador host.

2 Desde la pantalla de Microsoft ActiveSync del ordenador host, haga 
clic en el botón Sync (Sincronizar).

La sincronización comienza y el estado se muestra en la parte inferior de la 
pantalla.

Copia de seguridad manual mediante el 
arrastre de archivos

 AVISO: Debe realizar copias de seguridad manuales de los archivos que no 
están seleccionados en la configuración de Options (Opciones). Los archivos 
de los que se ha hecho copia de seguridad manualmente se arrastran a una 
carpeta distinta del escritorio del ordenador host.
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Sólo se realizan copias de seguridad automáticas (sincronizadas) de los 
tipos de datos que se seleccionaron cuando se estableció una asociación o 
al cambiar las selecciones de la opción de sincronización. Puede realizar 
copias de seguridad de otros datos arrastrando de forma manual los 
archivos a una carpeta diferente del ordenador host.

Por ejemplo, cree una carpeta en el escritorio denominada Other Axim 
Files (Otros archivos de Axim). Use Other Axim Files (Otros archivos de 
Axim) para guardar los archivos que no se guardan automáticamente.

1 Desde la pantalla Microsoft ActiveSync, haga clic en Explore 
(Explorar). Aparece la ventana Mobile Device (Dispositivo móvil).

2 Desde la ventana Mobile Device (Dispositivo móvil), vaya a cualquier 
archivo o carpeta.

3 Seleccione el archivo o carpeta y arrástrelo a la carpeta Other Axim 
Files (Otros archivos de Axim) del ordenador host.

Confirmación de la copia de seguridad
Confirme que todos los datos que desea tienen una copia de seguridad en el 
ordenador host. Se perderán todos los datos de los que no se haya realizado 
copia de seguridad antes de actualizarse a Windows Mobile Version 5.0 for 
Pocket PC Premium Edition. Compruebe los siguientes elementos:

• Bandeja de entrada de correo electrónico de Outlook

• Entradas del calendario de Outlook

• Contactos de Outlook

• Entradas de tareas de Outlook

• Notas de Outlook

• Favoritos

• Archivos que se han sincronizado y colocado automáticamente en 
la carpeta Pocket_PC My Documents (Mis documentos de 
Pocket_PC)

• Archivos que se han arrastrado manualmente a la carpeta Other 
Axim Files (Otros archivos de Axim) del ordenador host

• ROM anterior que se ha arrastrado a la carpeta Other Axim Files 
(Otros archivos de Axim)
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Introducción de información
Existen varias opciones para introducir información:

• Utilizar el panel de entrada para introducir texto tecleado mediante el 
teclado de la pantalla u otro método de entrada

• Escribir directamente en la pantalla con el lápiz.

• Trazar dibujos en la pantalla con el lápiz

• Hablar por el micrófono del dispositivo para grabar un mensaje 

Utilice Microsoft® ActiveSync® para sincronizar información del 
ordenador con el dispositivo o para copiar información del ordenador en el 
dispositivo. Para obtener más información, consulte la Ayuda de 
ActiveSync en el ordenador.

 NOTA: Es posible que el sistema operativo en algunos idiomas no sea 
compatible con determinadas funciones mencionadas en este apartado.

Introducción de texto mediante el panel de entrada

Utilice el panel de entrada para introducir información en cualquier 
programa del dispositivo. Puede escribir con el teclado de la pantalla o con 
el lápiz mediante Letter Recognizer (Reconocedor de letras), Block 
Recognizer (Reconocedor de bloques) o Transcriber (Transcriptor). Los 
caracteres aparecen en la pantalla como texto tecleado.

Para mostrar u ocultar el panel de entrada, puntee en el icono del panel de 
entrada. Puntee en la flecha que hay junto al icono del panel de entrada 
para cambiar el método de entrada.

Icono del panel 
de entrada
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Cuando utilice el panel de entrada, el dispositivo se anticipará a la palabra 
que usted esté escribiendo y la mostrará encima del panel de entrada. 
Cuando puntee en la palabra que se muestra, ésta se insertará en el punto 
de inserción. Cuanto más utilice el dispositivo, a más palabras será capaz 
de anticiparse.

Para cambiar las opciones de sugerencia de palabras, como por ejemplo, el 
número de palabras sugeridas:

1 Puntee en Inicio→ Configuración→ Personal→ Input (Entrada).
2 Puntee en la ficha Word Completion (Terminación de palabras).

3 Seleccione los valores que desee y puntee en OK (Aceptar).

Escritura con el teclado de pantalla

1 Puntee en la flecha de selección de entrada y en el Teclado.

2 Puntee en las teclas del teclado de la pantalla con el lápiz.

Palabras sugeridas
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Reconocedor de letras

El reconocedor de letras permite utilizar el lápiz para escribir letras en la 
pantalla tal como lo haría en un papel.

 NOTA: El reconocedor de letras se incluye con los sistemas operativos en inglés, 
francés, alemán, italiano y español. Las otras versiones no admiten esta opción.

1 Puntee en la flecha de selección de entrada y en Letter Recognizer 
(Reconocedor de letras).

2 Escriba caracteres, números y símbolos en el área de escritura designada. 

• Escriba mayúsculas en el área de ABC (izquierda) del cuadro. 

• Escriba letras minúsculas utilizando el área abc (en el medio) del 
cuadro. 

• Escriba números en el área 123 (derecha) del cuadro. 

• Escriba signos de puntuación y símbolos punteando en cualquier 
parte del cuadro y, a continuación, escriba el carácter deseado. 

Las letras se convierten en texto tecleado en la pantalla. Para obtener 
instrucciones específicas sobre cómo utilizar el reconocedor de letras, 
puntee en el signo de interrogación que se encuentra junto al área de 
escritura.

 NOTA: Puntee en Demo para ver los trazos de caracteres que el dispositivo 
puede reconocer.

Reconocedor de bloques

El reconocedor de bloques permite utilizar trazos de caracteres parecidos a 
los que utilizan otros dispositivos de bolsillo.

 NOTA: El reconocedor de bloques se incluye con los sistemas operativos en inglés, 

francés, alemán, italiano y español. Las otras versiones no admiten esta opción.

1 Puntee en la flecha de selección de entrada y en Block Recognizer 
(Reconocedor de bloques).

2 Escriba caracteres, números y símbolos en el área de escritura designada. 

• Escriba letras en el área abc (izquierda) del cuadro. 

• Escriba números en el área 123 (derecha) del cuadro. 

• Escriba símbolos y signos de puntuación punteando en cualquier 
parte del cuadro y, a continuación, escriba el carácter deseado. 
Funcionamiento de Axim 67



Los trazos de carácter se convierten en texto tecleado en la pantalla. 
Para obtener instrucciones específicas sobre cómo utilizar el 
reconocedor de bloques, puntee en el signo de interrogación que se 
encuentra junto al área de escritura.

 NOTA: Puntee en Demo para ver los trazos de caracteres que el dispositivo 
puede reconocer.

Transcriptor

El transcriptor permite escribir con el lápiz en cualquier parte de la 
pantalla de forma parecida a como lo haría en un papel. A diferencia del 
reconocedor de letras y el reconocedor de bloques, esta opción permite 
escribir una o más frases y, a continuación, hacer una pausa para dejar que 
el transcriptor cambie los caracteres escritos por caracteres tecleados.

 NOTA: El transcriptor se incluye con los sistemas operativos en inglés, francés 
y alemán. Las otras versiones no admiten esta opción.

1 Inicie un programa como Word Mobile. 

2 Puntee en el icono Input Panel (Panel de entrada) situado en la parte 
inferior central de la pantalla y puntee en la flecha de selección de 
entrada en la derecha del icono. 

3 Puntee en Transcriber (Transcriptor).
Aparecerá la pantalla de introducción al transcriptor. 

4 Con el lápiz, escriba en cualquier parte de la pantalla.

Cuando haga una pausa, el transcriptor convertirá los caracteres 
escritos en caracteres tecleados. Para obtener instrucciones específicas 
sobre cómo utilizar el transcriptor, puntee en el signo de interrogación 
situado en la esquina inferior derecha de la pantalla.

Escritura en la pantalla
En cualquier programa que acepte texto escrito, como la aplicación Notas 
y la ficha Notas de algunos programas, puede utilizar el lápiz para escribir 
directamente en la pantalla. Puede editar y formatear lo que ha escrito, y 
convertir la información en texto posteriormente.
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Edición de texto escrito

Para editar o formatear el texto escrito:

1 Arrastre el lápiz a lo largo del texto que desea seleccionar.

2 Puntee y mantenga el lápiz en el texto seleccionado.

3 Puntee en el comando de edición apropiado en el menú emergente.

También puede puntear en Menu→ Edit (Menú→ Editar), en la parte 
inferior de la pantalla para seleccionar los comandos de edición.

Para convertir el texto escrito en texto de imprenta, puntee en Menu→ 
Tools (Menú→ Herramientas) y en Recognize (Reconocer).
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Si desea convertir sólo determinadas palabras, selecciónelas antes de 
puntear en Recognize (Reconocer), o bien puntee y mantenga el lápiz en 
las palabras seleccionadas y luego puntee en Recognize (Reconocer) en el 
menú emergente. Si una palabra no se reconoce, no se convertirá en texto 
de imprenta.

Si la conversión es incorrecta, puede seleccionar palabras diferentes en la 
lista de alternativas o regresar al texto escrito original:

1 Puntee y mantenga el lápiz en la palabra incorrecta. 

2 En el menú emergente, puntee en Alternates (Alternativos). 

Aparece un menú con una lista de palabras alternativas.

3 Puntee en la palabra correcta o en el texto escrito en la parte superior 
del menú para regresar al texto escrito original.
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Consejos para lograr un buen reconocimiento:

• Escriba claramente.

• Escriba sobre las líneas y, en las letras que tengan extremos inferiores, 
escríbalos debajo de la línea. Trace la intersección de la “t” y escriba los 
apóstrofes debajo de la línea superior para evitar que se confundan con 
las palabras de arriba. Escriba los puntos y las comas encima de la línea.

• Para obtener un mejor reconocimiento, intente cambiar el grado de 
zoom a 300% punteando en Menu→ Zoom (Menú→ Zoom).

• Escriba las letras de una palabra juntas y deje espacios grandes entre las 
palabras, de manera que el dispositivo pueda determinar fácilmente 
dónde comienzan y terminan las palabras.

• Las palabras con guiones y las palabras en las que se utilizan caracteres 
especiales como, por ejemplo, acentos y algunos signos de puntuación, 
no se pueden convertir.

• No es posible agregar texto escrito a una palabra para cambiarla una vez 
que se haya reconocido. Deberá borrar la palabra escrita y escribir la 
palabra nueva.

Palabras 
alternativas
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Cómo dibujar en la pantalla

Puede dibujar en la pantalla del mismo modo que escribe en ella. Sin 
embargo, la selección y edición de dibujos es distinta a la selección y 
edición de texto escrito. Por ejemplo, es posible cambiar el tamaño de los 
dibujos seleccionados, pero no del texto escrito.

Creación de un dibujo

 NOTA: Para acercar o alejar el dibujo, puntee en Menu→ Zoom (Menú→ Zoom) 

y en un grado de zoom.

En el primer trazo que realice, cruce tres renglones. Aparece un cuadro de 
dibujo. Los trazos posteriores que toquen o que estén dentro del cuadro 
de dibujo formarán parte del dibujo. Los dibujos que no crucen los tres 
renglones se tratarán como texto escrito.

Cuadro de dibujo
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Edición de un dibujo

Para editar o formatear un dibujo, deberá seleccionarlo primero:
1 Puntee y mantenga el lápiz en el dibujo hasta que aparezcan los 

selectores.
Para seleccionar varios dibujos, arrastre el lápiz por encima ellos.

2 Puede cortar, copiar y pegar dibujos seleccionados; para ello, puntee y 
mantenga los dibujos seleccionados y, a continuación, puntee en un 
comando de edición del menú emergente.
Asimismo, puede puntear en Menu→ Edit (Menú→ Editar), en la 
parte inferior de la pantalla para seleccionar los comandos de edición.

Para ajustar el tamaño de un dibujo, arrastre un selector.

Grabación de un mensaje

En un programa en el que se puede escribir o dibujar en la pantalla, 
también puede capturar rápidamente ideas, recordatorios o números de 
teléfono grabando un mensaje. 
• En Calendario, Tareas y Contactos, puede incluir una grabación en la 

ficha Notas. 
• En la aplicación Notas, puede crear una grabación independiente o 

bien puede incluir una grabación en una nota escrita. Si desea incluir 
una grabación en una nota, abra primero la nota. 

• En el programa Messaging (Mensajería), se puede agregar una 
grabación a un mensaje de correo electrónico. 

Para grabar un mensaje: 
1 Sostenga el micrófono cerca de su boca u otra fuente de sonido.
2 Presione y mantenga presionado el botón Record (Grabación), situado en 

la parte lateral del dispositivo, hasta que se emita un sonido.
3 Mientras mantiene presionado el botón Record (Grabación), realice la 

grabación.
4 Para dejar de grabar, suelte el botón Record (Grabación). 

El dispositivo emitirá un sonido dos veces. La nueva grabación 
aparecerá en la lista de notas o como un icono incorporado.

 NOTA: También puede realizar una grabación punteando en el icono Record 
(Grabación) en la barra de herramientas de grabación.

Para reproducir una grabación, puntee en el nombre de la misma en la lista 
o puntee en el icono de altavoz en la nota.
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Utilización de Mi texto

Cuando utilice Messaging (Mensajería) o MSN Messenger, use My text 
(Mi texto) para insertar rápidamente mensajes predefinidos o de uso 
frecuente. Para insertar un mensaje, puntee en Menu→ My Text 
(Menú→ Mi texto) y en un mensaje.

 NOTA: Es posible agregar texto al mensaje de My Text (Mi texto) una vez que 
se ha insertado.

Para editar un mensaje de My Text (Mi texto):
1 Puntee en Menu→ My Text→ Edit My Text Messages (Menú→ Mi 

texto→ Modificar mensajes de texto).
2 Realice los cambios necesarios y puntee en OK (Aceptar).

Ajuste de la configuración
Puede ajustar la configuración del dispositivo para adaptarlo a su forma de 
trabajar. Para ver las opciones disponibles, puntee en Inicio→ Configuración.

 NOTA: Según las características del dispositivo, las fichas pueden contener a 
su vez fichas y elementos adicionales.

Consulte la ayuda del dispositivo para obtener información adicional 
sobre el ajuste de la configuración (puntee en Inicio→ Ayuda).
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Ficha Personal

• Buttons (Botones): asigne los programas que se iniciarán cuando 
presione los botones del dispositivo.

• Input (Entrada): ajuste la configuración del método de entrada, de la 
conclusión de palabra y de otras opciones.

• Menus (Menús): agregue o quite elementos en el menú Inicio.

• Owner Information (Información del propietario): introduzca la 
información de contacto.

• Password (Contraseña): establezca una contraseña para proteger los 
datos almacenados en el dispositivo.

• Sounds & Notification (Sonidos y notificación): ajuste el volumen y 
establezca las notificaciones. Para obtener más información, consulte el 
apartado “Notificaciones” en la página 93.

• Today (Hoy): personalice la apariencia de la pantalla Today (Hoy) y la 
información que ésta muestra.

• MSN Options (Opciones de MSN): configuración que puede utilizar 
para personalizar Pocket MSN.

Ficha Sistema

• About (Acerca de): busque información acerca de Windows Mobile 5.0 y 
su dispositivo.

• Brightness (Brillo): ajuste la configuración del brillo para ahorrar energía.

• Certificates (Certificados): visualice o elimine los certificados 
almacenados en el dispositivo. Los certificados le ayudan a establecer 
su identidad y la de otros ordenadores a fin de evitar que usuarios no 
autorizados puedan acceder a sus datos.

• Clock & Alarms (Reloj y alarmas): cambie la hora y establezca la alarma.

• Memory (Memoria): asigne memoria para el almacenamiento de 
programas y datos. Vea la memoria libre y la utilizada, la memoria de la 
tarjeta de almacenamiento y los programas en ejecución.

• Error Reporting (Creación de informes de error): envíe la información 
que necesitan los grupos de soporte técnico para diagnosticar el error 
de un programa instalado en un dispositivo en el que ejecute el 
software de Windows Mobile. Para que eso sea posible, el dispositivo 
debe estar conectado a Internet.
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• GPS: ajuste la configuración cuando disponga de un dispositivo GPS 
conectado para saber cuál es el lugar exacto en el que se encuentra, con 
la ayuda de mapas. Tenga en cuenta que el dispositivo Axim no tiene 
un dispositivo GPS integrado.

• Mirror Mode (Modo de duplicación): está sólo disponible en el 
modelo X51v. El modo de duplicación permite a los usuarios ver la 
misma imagen en la pantalla del PDA y en una pantalla externa 
mediante el uso de un cable VGA. Cuando esté activado, se mostrará 
un icono en la barra de comandos. Para desactivar el modo de 
duplicación, haga clic en el icono o desmarque la casilla de verificación. 

• Microphone (Micrófono): ajuste el volumen del micrófono.

• Power (Energía): revise la batería o el estado de la carga. Utilice la ficha 
Advanced (Avanzadas) para establecer el período de tiempo que el 
dispositivo puede permanecer inactivo antes de apagarse. Utilice la 
ficha de botón de alimentación para configurar el botón de encendido 
de modo que apague el dispositivo completamente. De esta forma, se 
ahorrará batería.

• Regional Settings (Configuración regional): visualice y cambie el 
formato de la configuración regional, como la moneda, la hora y la fecha.

• Remove Programs (Quitar programas): quite programas del dispositivo. 
Para obtener más información, consulte el apartado “Adición y 
eliminación de programas” en la página 109.

• Screen (Pantalla): ajuste la pantalla si el dispositivo no responde de 
manera correcta cuando se puntea en él, y seleccione la orientación de 
pantalla que desea utilizar. 

• Switcher Bar (Barra del conmutador): ajuste la configuración de la 
utilidad para iniciar el programa Switcher Bar.

• System Information (Información del sistema): visualice información 
técnica del dispositivo.

Ficha Conexiones

• Beam (Transferir): reciba rayos infrarrojos de otros dispositivos.
• Bluetooth: encienda y apague la radio con tecnología inalámbrica 

Bluetooth®, y cree y edite dispositivos conectados. De manera 
predeterminada, la radio está apagada.

• Connections (Conexiones): agregue y configure conexiones de módem 
y de servidor.
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• Dell WLAN Utility (Utilidad WLAN Dell): únicamente disponible en 
dispositivos con Wi-Fi interna. Utilice la utilidad WLAN para 
conectarse a la red inalámbrica mediante EAP/TTLS.

• Network Cards (Tarjetas de red): configure los valores del adaptador de 
red.

• Odyssey Client (Cliente Odyssey): proporciona una conexión y 
autenticación seguras de LAN (WLAN) inalámbrica. Tenga en cuenta 
que sólo está disponible para las versiones media y alta de Axim.
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Comunicación y programación

Acerca del programa Microsoft® ActiveSync®

Microsoft ActiveSync 4.1 es el último software de sincronización de Axim. 
ActiveSync transfiere archivos y datos entre el dispositivo y el ordenador. 
Puede cargar controladores y programas en el dispositivo. ActiveSync se debe 
instalar antes de conectar el dispositivo al ordenador. Puede encontrar el 
programa de instalación ActiveSync en el CD de inicio de Dell.
Puede sincronizar la información del ordenador con la información del 
dispositivo mediante el uso de ActiveSync. Este software compara los datos 
del dispositivo con los datos del ordenador y actualiza los dos sistemas con la 
información más reciente. Por ejemplo,
• Mantener actualizados los datos de Microsoft Pocket Outlook 

sincronizando el dispositivo con los datos de Microsoft Outlook del 
ordenador. 

• Sincronizar los archivos de Microsoft Word y Microsoft Excel entre el 
dispositivo y el ordenador. Los archivos se convierten automáticamente al 
formato correcto.

 NOTA: De forma predeterminada, ActiveSync no sincroniza automáticamente 
todos los tipos de información. Puede cambiar las opciones de ActiveSync para 
sincronizar tipos específicos de información.

Con ActiveSync, también puede:

• Copiar (en lugar de sincronizar) archivos entre el dispositivo y el ordenador.
• Controlar cuando se produce la sincronización. Por ejemplo, puede 

sincronizar continuamente o sólo cuando seleccione el comando de 
sincronización.

• Seleccionar qué tipos de información se sincronizan y controlar cuántos 
datos se sincronizan. Por ejemplo, puede seleccionar cuántas semanas de 
citas pasadas desea sincronizar.

Para sincronizar los datos, es necesario tener las versiones de ActiveSync para 
Microsoft Windows® y Pocket PC. Debe instalar la versión para Windows 
de ActiveSync en su ordenador mediante el CD de inicio de Dell™. La 
versión para Pocket PC ya viene instalada en el dispositivo.
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 NOTA: Antes de conectar el dispositivo a un ordenador por primera vez, 
asegúrese de que instala ActiveSync en el ordenador con el CD de inicio de 

Dell™.

 NOTA: Si el dispositivo Axim no puede llevar a cabo la sincronización, 
compruebe el software de seguridad del ordenador para ver si el servidor de 
seguridad se está ejecutando. Los servidores de seguridad pueden bloquear la 
comunicación entre el ordenador y el PDA Axim. 

Instalación y uso de ActiveSync
Para instalar ActiveSync:

1 Inserte el CD de inicio de Dell.
2 Haga clic en Getting Started (Inicio) para acceder al menú principal.
3 Haga clic en Start Here (Empezar aquí).
4 Haga clic en Install ActiveSync (Instalar ActiveSync) y siga las 

instrucciones que aparecen en la pantalla.
Cuando la instalación se haya completado, conecte el dispositivo al 
ordenador. El asistente para la instalación de ActiveSync le permitirá: 
• Establecer una asociación, de modo que pueda sincronizar la 

información entre el dispositivo y el ordenador.
• Personalizar la configuración de la sincronización
El primer proceso de sincronización se iniciará automáticamente cuando 
concluya el asistente. 

 NOTA: El dispositivo se debe encender para que se pueda llevar a cabo el 
proceso de sincronización.

Durante la primera sincronización, la información almacenada en la 
aplicación Outlook del ordenador se copiará en las aplicaciones 
Calendario, Contactos y Tareas del dispositivo.

Una vez que haya configurado ActiveSync y haya completado el primer 
proceso de sincronización, podrá iniciar la sincronización desde el dispositivo. 
Para pasar a ActiveSync en el dispositivo, puntee en Inicio→ ActiveSync. 

Si desea encontrar información sobre cómo utilizar ActiveSync en el 
dispositivo, abra ActiveSync en el dispositivo y puntee en Inicio→ Ayuda.

Para encontrar información sobre cómo utilizar ActiveSync en el 
ordenador, haga clic en Ayuda→ Ayuda de Microsoft ActiveSync.

 NOTA: Para obtener más ayuda de ActiveSync, visite la página: 
http://www.microsoft.com/windowsmobile/help/activesync/default.mspx
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Acerca de Microsoft® Pocket Outlook
Pocket Outlook incluye las aplicaciones Calendario, Contactos, Tareas, 
Messaging (Mensajería) y Notas. Puede utilizar estos programas de forma 
individual o conjunta. Por ejemplo, puede utilizar las direcciones de correo 
electrónico almacenadas en Contactos para enviar mensajes de correo 
electrónico en Messaging (Mensajería).

 NOTA: Pocket Outlook está preinstalado en el dispositivo. Si no está instalado, 
encontrará una copia del programa de instalación de Pocket Outlook en el CD 

de inicio de Dell. Asegúrese de que instala Pocket Outlook y no Outlook 
Express. Tenga en cuenta que sólo puede instalar Pocket Outlook una vez 
desde el programa, puesto que se trata de una versión bajo licencia.

Con Microsoft ActiveSync® puede sincronizar información de Microsoft 
Outlook o Microsoft Exchange del ordenador. También puede sincronizar 
esta información directamente con un servidor Exchange. Cada vez que se 
realiza una sincronización, ActiveSync compara los cambios realizados en 
el dispositivo y en el ordenador o servidor y actualiza los dos con la 
información más reciente. Para obtener más información sobre cómo 
utilizar ActiveSync, consulte la Ayuda de ActiveSync en el ordenador.
Puede pasar a cualquiera de los programas siguientes por medio del menú 
Inicio.

 NOTA: Si desea obtener información detallada sobre las aplicaciones 
Calendar (Calendario), Contacts (Contactos), Tasks (Tareas), Messaging 
(Mensajería) y Notes (Notas), entre otras, consulte la Ayuda en el dispositivo.

Categorías
Utilice categorías para agrupar citas, tareas y contactos relacionados. Por 
ejemplo, puede asignar contactos relacionados con el trabajo a la categoría 
Business (Empresa) y contactos personales a la categoría Personal, de 
modo que puede encontrar información de los contactos rápidamente.  
Asimismo, puede crear sus propias categorías, como Familia, para agrupar 
la información de los contactos de los familiares.

Creación de una categoría

Para crear una categoría:
1 En el programa, puntee en un elemento existente o cree uno nuevo. 
2 En el caso de un elemento nuevo en las aplicaciones Calendar 

(Calendario), Contacts (Contactos) y Tasks (Tareas), puntee en 
Categories (Categorías).
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3 Puntee en New (Nuevo), escriba el nombre de la categoría y puntee en 
Done (Fin). 
La nueva categoría se asignará automáticamente al elemento. 

4 En el caso de un elemento existente en Calendar (Calendario) y Tasks 
(Tareas), puntee en Edit→ Categories (Editar→ Categorías). 

5 En el caso de un elemento existente en Contacts (Contactos), puntee 
en Menu→ Edit→ Categories (Menú→Editar→ Categorías).

6 Puntee en OK (Aceptar) para volver a la cita, contacto o tarea. 

Calendario
La aplicación Calendario sirve para programar citas, como reuniones y 
otros eventos. Puede consultar las citas en una de las varias vistas (Agenda, 
Día, Semana, Mes y Año) y cambiar fácilmente de vista utilizando el 
menú de vista. Puntee en el icono Today (Hoy) para ver la fecha actual.

 NOTA: Si desea personalizar Calendar (Calendario), por ejemplo, si desea 
cambiar el primer día de la semana, puntee en Menu (Menú) y en Options 
(Opciones). 

Icono de hoy

Icono del panel de entrada
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Para crear una cita:
1 Puntee en Inicio→ Calendar (Calendario). 
2 Puntee en Menu (Menú)→ New Appointment (Cita nueva). 
3 Escriba un nombre para la cita y escriba información como, por 

ejemplo, las horas de inicio y de fin. 
4 Si desea programar un evento que durará todo el día, en el cuadro All 

Day (Todo el día), puntee en Yes (Sí).
5 Cuando haya acabado, puntee en OK (Aceptar) para volver al calendario. 

Si desea recibir el recordatorio de una cita:
1 Puntee en Inicio→ Calendar→ Menu→ Options→ Appointments 

(Calendario→ Menú→ Opciones→ ficha Citas). 
2 Seleccione la casilla de verificación Set reminders for new items 

(Establecer recordatorios para los elementos nuevos). 
3 Establezca la hora en la que desee que aparezca el recordatorio. 
4 Puntee en OK (Aceptar) para volver al calendario. 

Uso de la pantalla de resumen

Cuando puntee en una cita en la aplicación Calendar (Calendario), 
aparecerá una pantalla de resumen. Para cambiar la cita, puntee en Edit 
(Editar).

Creación de convocatorias de reuniones

Puede utilizar el calendario para establecer reuniones con usuarios de 
Outlook o Pocket Outlook. La convocatoria de reunión se crea 
automáticamente al sincronizar la aplicación Messaging (Mensajería) o al 
conectarse al servidor de correo electrónico. Si desea establecer la forma 
en que desea que se envíen las convocatorias de reunión, puntee en Menu 
(Menú) y en Options (Opciones). 

Para programar una reunión:

1 Puntee en Inicio→ Calendar (Calendario). 
2 Programe una cita nueva o abra una existente y puntee en Edit (Editar).

3 Puntee en Attendees (Asistentes).
4 Puntee el nombre del contacto al que desee invitar. 
5 Si desea invitar a cada asistente adicional, puntee en Add (Agregar) y 

en el nombre. 
6 Puntee en OK (Aceptar).
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La convocatoria de la reunión se enviará a los asistentes la siguiente vez 
que sincronice el dispositivo con el PC.
Si desea obtener más información sobre el envío y la recepción de 
convocatorias de reuniones, puntee en Inicio→ Help→ Calendar o 
Messaging (Ayuda→ Calendario o Mensajería).

Contactos
La aplicación Contactos sirve para mantener una lista de sus amigos y 
colegas. También puede compartir rápidamente la información de Contactos 
con otros usuarios de dispositivos mediante el puerto de infrarrojos.

 NOTA: Para cambiar la presentación de la información en la lista, puntee en 
Menu→ Options (Menú→ Opciones).

Para crear un contacto:
1 Puntee en Inicio→ Contacts→ New (Contactos→ Nuevo).
2 Utilizando el panel de entrada, introduzca un nombre y otra 

información para el contacto. Desplácese hacia abajo para ver todos los 
campos disponibles.

Campo de 
búsqueda

Categoría
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3 Para asignar el contacto a una categoría, puntee en Categorías y 
seleccione una categoría de la lista. 
En la lista de contactos, puede mostrar los contactos ordenados por 
categoría.

4 Para agregar notas, puntee en la ficha Notas. Puede introducir texto, 
dibujar o crear una grabación. Para obtener más información sobre 
cómo crear notas, consulte el apartado “Notas” en la página 87.

5 Cuando haya terminado de introducir la información, puntee en OK 
(Aceptar) para regresar al calendario.  

Búsqueda de un contacto

Para encontrar un contacto: 

1 Puntee en Inicio→ Contacts (Contactos). 
2 Si no está en la vista Name (Nombre), puntee en Menu→ View By→ 

Name (Menú→ Ver por→ Nombre).
3 Realice uno de los siguientes pasos: 

• Empiece a escribir un nombre o número de teléfono en el cuadro 
de texto que aparece hasta que se muestre el contacto que desee. 
Para mostrar todos los contactos de nuevo, puntee en el cuadro de 
texto y borre el texto, o puntee en la flecha hacia la derecha del 
cuadro de texto. 

• Utilice el índice alfabético que se muestra en la parte superior de la 
lista de contactos. 

• Filtre la lista por categorías. En la lista de contactos, puntee en 
Menu→ Filter (Menú→ Filtro), y a continuación, puntee en una 
categoría que haya asignado a un contacto. Si desea mostrar todos los 
contactos de nuevo, seleccione All Contacts (Todos los contactos)

4 Para ver los nombres de las compañías para las que trabajan los 
contactos, puntee en View (Ver) en la lista de contactos y luego puntee 
en By Company (Por compañía). El número de contactos que trabajan 
para una compañía concreta se mostrará a la derecha del nombre de 
dicha compañía. 

Uso de la pantalla de resumen

Cuando puntee en un contacto en la lista de contactos, aparecerá una 
pantalla de resumen. Para cambiar la información de contacto, puntee en 
Edit (Editar).
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Tareas

 NOTA: Para cambiar la presentación de la información en la lista, puntee en 
Menu→ Options (Menú→ Opciones).

Utilice la aplicación Tasks (Tareas) para crear una lista de las cosas que 
debe hacer.

Para crear una tarea:

1 Puntee en Inicio→ Programas→ Tasks (Tareas). 

2 Puntee en New (Nuevo), escriba un asunto para la tarea e introduzca 
información como, por ejemplo, la fecha de inicio y la fecha de fin. 

3 Cuando haya acabado, puntee en OK (Aceptar).
4 Para copiar una tarea existente de la lista de tareas, seleccione la tarea que 

desee copiar. Puntee en Menu→ Edit→ Copy, (Menú→ Editar→ 
Copiar) y, a continuación, en Menu→ Edit→ Paste (Menú→ Editar→ 
Pegar).

5 Para agregar notas, puntee en la ficha Notes (Notas). Puede introducir 
texto, dibujar o crear una grabación. Para obtener más información sobre 
cómo crear notas, consulte el apartado “Notas” en la página 87.

Menú para ordenar
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 NOTA: Para crear rápidamente una tarea con sólo un asunto, puntee en 
Menu→ Tool→ Options→ Show Tasks (Menú→ Herramienta→ Opciones→ 
Mostrar tareas). Puntee en la opción Tap here to add a new task (Puntee aquí 
para nueva tarea) e introduzca información de la tarea.

Notas
La aplicación Notas permite capturar rápidamente pensamientos, 
recordatorios, ideas, dibujos y números de teléfono. Puede crear una nota 
escrita o una grabación. También puede incluir una grabación en una nota. 
Si una nota está abierta cuando cree la grabación, ésta se incluirá en la nota 
como un icono. Si no hay ninguna nota abierta, la grabación se guardará 
como una grabación independiente.

Para crear una nota:

1 Puntee en Inicio→ Programas→ Notes→ New (Notas→ Nuevo).

2 Cree la nota escribiendo, dibujando, tecleando o realizando una 
grabación. Si desea obtener más información sobre cómo utilizar el 
panel de entrada, escribir y dibujar en la pantalla y crear grabaciones, 
consulte el apartado “Introducción de información” en la página 65.
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Messaging (Mensajería)
La aplicación Messaging (Mensajería) sirve para enviar y recibir mensajes 
de correo electrónico: 

• Sincronice mensajes de correo electrónico utilizando Exchange o 
Outlook en el ordenador.

• Envíe y reciba mensajes de correo electrónico conectándose 
directamente a un servidor de correo electrónico a través de un ISP o 
una red. 

 NOTA: Para crear una cuenta de correo electrónico para el dispositivo, 
póngase en contacto con su proveedor de servicios de Internet. Dell no 
proporciona este servicio.

Sincronización de mensajes de correo electrónico

Puede sincronizar mensajes de correo electrónico junto con el resto de los 
datos si activa la sincronización de la aplicación Messaging (Mensajería) en 
ActiveSync. Para obtener información sobre cómo activar la sincronización 
de Messaging (Mensajería), consulte la Ayuda de ActiveSync en el ordenador.

 NOTA: También puede sincronizar los mensajes de correo electrónico con el 
ordenador desde una ubicación remota. Para obtener más información, 
consulte el apartado “Cómo conectarse” en la página 95.

Durante la sincronización:

• Los mensajes se copian de las carpetas de correo electrónico de los 
programas Exchange o Outlook del ordenador en la carpeta ActiveSync 
de Messaging (Mensajería) del dispositivo De manera predeterminada, 
recibirá:

– Los mensajes de los últimos 3 días

– Las primeras 100 líneas de cada mensaje

– Los archivos adjuntos cuyo tamaño sea inferior a 100 KB

• Los mensajes de correo electrónico de la carpeta Bandeja de salida del 
dispositivo se transfieren a los programas Exchange o Outlook del 
ordenador, y luego se envían desde dichos programas.

• Para transferir los mensajes de correo electrónico almacenados en las 
subcarpetas del ordenador, debe seleccionarlos en ActiveSync.
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Conexión directa con un servidor de correo electrónico

Además de sincronizar mensajes de correo electrónico con el ordenador, 
puede enviar y recibir mensajes de correo electrónico conectándose a un 
servidor de correo electrónico mediante un módem o una tarjeta de red 
conectados al dispositivo. Para ello, deberá establecer una conexión 
remota a una red o un ISP, y una conexión al servidor de correo 
electrónico. Para obtener más información, consulte el apartado “Cómo 
conectarse” en la página 95.

Cuando se conecte al servidor de correo electrónico:

• Los mensajes nuevos se descargarán en la carpeta Bandeja de entrada 
del dispositivo.

• Se enviarán los mensajes de la carpeta Bandeja de salida del 
dispositivo.

• Los mensajes que se hayan eliminado del servidor de correo electrónico 
se borrarán de la carpeta Bandeja de entrada del dispositivo.

Los mensajes que reciba directamente de un servidor de correo electrónico 
se vincularán al servidor de correo electrónico, no al ordenador. Cuando 
suprima un mensaje del dispositivo, también se suprimirá del servidor de 
correo electrónico la próxima vez que se conecte, en función de la 
configuración que haya seleccionado en ActiveSync.

Cuando trabaja sin conexión, puede leer y responder los mensajes 
mientras está conectado al servidor de correo electrónico. Los mensajes se 
envían tras puntear en Send (Enviar), lo cual supone un ahorro de espacio 
en el dispositivo.

Una vez que haya descargado los encabezados de los mensajes nuevos o 
mensajes parciales, puede desconectarse del servidor de correo electrónico y 
decidir qué mensajes desea descargar completamente. La próxima vez que 
se conecte, el programa Messaging (Mensajería) descargará los mensajes 
que haya marcado con el fin de recuperarlos y enviará los mensajes que 
haya escrito.

Utilización de la lista de mensajes

Los mensajes que recibe se muestran en la lista de mensajes. De forma 
predeterminada, los mensajes recibidos más recientemente se muestran 
antes en la lista.

Cuando reciba un mensaje, puntee en él para abrirlo. Los mensajes no 
leídos se muestran en negrita.
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Los mensajes originales permanecen en el servidor de correo electrónico 
del ordenador. Puede marcar los mensajes que desee recuperar 
completamente durante la siguiente sincronización o conexión al servidor 
de correo electrónico. En la lista de mensajes, puntee y mantenga el lápiz 
en el mensaje que desea recuperar. En el menú emergente, puntee en 
Mark for Download (Marcar para descarga). Los iconos de la lista de mensajes 
de la bandeja de entrada indican el estado de los mensajes.

Especifique sus preferencias de descarga cuando configure el servicio o 
seleccione las opciones de sincronización. Puede cambiar la configuración 
en cualquier momento:

• Cambie las opciones de sincronización de Messaging (Mensajería) 
utilizando las opciones de ActiveSync. Para obtener más información, 
consulte la Ayuda de ActiveSync en el ordenador.

• Cambie las opciones para establecer conexiones directas al servidor de 
correo electrónico en el programa Messaging (Mensajería) de su 
dispositivo. Puntee Menu→ Options (Menú→ Opciones). En la ficha 
Account (Cuenta), puntee en el servicio que desee cambiar. Puntee y 
mantenga el lápiz en el servicio y, a continuación, seleccione Delete 
(Eliminar) para borrar el servicio.

Redacción de mensajes
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Para escribir y enviar un mensaje:

1 En la lista de mensajes, puntee en Menu→ Switch Accounts 
(Menú→ Cambiar cuentas) y seleccione la cuenta.

2 Puntee en New (Nuevo).

3 Escriba la dirección de correo electrónico de uno o más destinatarios, 
separándolos mediante punto y coma. Si desea acceder a las 
direcciones y números de teléfono de la aplicación Contacts 
(Contactos), puntee en To (A).

4 Escriba su mensaje. Para agregar mensajes comunes con rapidez, puntee 
en Menu→ My Text (Menú→ Mi texto) y en el mensaje que desee. 

5 Para comprobar la ortografía, puntee en Menu→ Spell Check 
(Menú→ Ortografía).

6 Puntee en Send (Enviar).

Si trabaja fuera de línea, el mensaje pasará a la carpeta Outbox 
(Bandeja de salida) y se enviará la próxima vez que se conecte a la red.

Gestión de carpetas y mensajes de correo electrónico

De manera predeterminada, los mensajes se muestran en una de las cinco 
carpetas para cada servicio que haya creado: Inbox (Bandeja de entrada), 
Deleted Items (Elementos eliminados), Drafts (Borradores), Outbox 
(Bandeja de salida) o Sent Items (Elementos enviados). La carpeta 
Deleted Items (Elementos eliminados) contiene mensajes que se han 
borrado del dispositivo. El comportamiento de las carpetas Deleted Items 
(Elementos eliminados) y Sent Items (Elementos enviados) depende de 
las opciones que haya seleccionado. Para cambiar las opciones, puntee en 
Menu→ Tools (Menú→ Herramientas) en la lista de mensajes y puntee 
en Options (Opciones). En la ficha Message (Mensaje), seleccione las 
opciones que desee.

Para crear, renombrar o suprimir una carpeta, puntee en Menu→ Tools→ 
Manage Folders (Menú→ Herramientas→ Administrar carpetas). Para 
mover un mensaje a otra carpeta, puntee y mantenga el lápiz en el 
mensaje de la lista de mensajes y, a continuación, puntee en Move to 
(Mover a) en el menú emergente.
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Comportamiento de las carpetas con una conexión directa a un servidor de 

correo electrónico

El comportamiento de las carpetas que ha creado dependerá de si utiliza 
ActiveSync, POP3 o IMAP4. 

• Si utiliza ActiveSync, los mensajes de correo electrónico de la carpeta 
Inbox (Bandeja de entrada) en Outlook se sincronizan 
automáticamente con el dispositivo. Puede sincronizar carpetas 
adicionales designándolas para ActiveSync. Las carpetas que cree y los 
mensajes que mueva se duplicarán en el servidor. Por ejemplo, si mueve 
mensajes de la carpeta Inbox (Bandeja de entrada) a una carpeta 
denominada Family (Familia) y ha designado Family (Familia) para 
que se sincronice, el servidor creará una copia de la carpeta Family 
(Familia) y copiará los mensajes en dicha carpeta. Entonces podrá leer 
los mensajes mientras esté lejos del ordenador.

• Si utiliza POP3 y mueve los mensajes de correo electrónico a una 
carpeta creada por usted, se romperá el vínculo entre los mensajes del 
dispositivo y las copias de dichos mensajes, ubicadas en el servidor de 
correo electrónico. La próxima vez que se conecte, el servidor de correo 
electrónico detectará que los mensajes no están en la bandeja de 
entrada del dispositivo y los borrará del servidor. Esto previene que 
tenga copias duplicadas de un mensaje. Sin embargo, sólo puede 
acceder a este contenido de la carpeta desde el dispositivo.

• Si utiliza IMAP4, las carpetas que cree y los mensajes de correo 
electrónico que mueva se duplicarán en el servidor. Por lo tanto, los 
mensajes estarán a su disposición en cualquier momento que se 
conecte al servidor de correo electrónico, ya sea desde el dispositivo o 
desde el ordenador. Esta sincronización de carpetas se producirá 
siempre que se conecte al servidor, cree carpetas nuevas, renombre o 
suprima carpetas mientras está conectado. 
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Notificaciones
Puede configurar este dispositivo para que le avise cuando tenga algo que 
hacer. Por ejemplo, si ha definido una cita en Calendario, una tarea con 
una fecha de vencimiento en Tareas o una alarma en Reloj, se le notificará 
de una de las maneras siguientes:

• Aparecerá un cuadro de mensaje en la pantalla

• Se reproducirá un sonido, que puede especificar

• Parpadeará un indicador luminoso en el dispositivo

Para configurar los recordatorios y sonidos del dispositivo:

1 Puntee en Inicio→ Configuración. 

2 En la ficha Personal, puntee en Sounds & Notifications (Sonidos y 
notificaciones). 

• Ficha Sounds (Sonidos): ajuste el volumen y active los sonidos

• Ficha Notifications (Notificaciones): establezca notificaciones 
para determinados eventos

Transmisión de un elemento
En los programas Calendar (Calendario), Contacts (Contactos), Notes 
(Notas), Tasks (Tareas), Excel Mobile, Word Mobile, PowerPoint Mobile 
y Pictures (Imágenes) puede transferir archivos e información a otros 
dispositivos mediante Bluetooth o infrarrojos. 

1 En el programa, seleccione el elemento que desee transferir como, por 
ejemplo, una cita en Calendar (Calendario), una tarea en Tasks 
(Tareas) una tarjeta de contacto en Contacts (Contactos) o un archivo 
en File Manager (Administrador de archivos). 

2 Puntee en Menu→ Beam (Menú→ Transferir) [tipo de elemento]. 

3 Realice uno de los siguientes pasos: 

• Si utiliza Bluetooth, puntee en el dispositivo al que desea enviar el 
elemento. 

• Si utiliza infrarrojos, alinee los puertos infrarrojos (IR) a corta 
distancia hasta que aparezca el nombre del dispositivo de destino y, 
a continuación, puntee en el dispositivo al que desea enviar el 
elemento. 
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Utilización del Explorador de archivos
El Explorador de archivos permite examinar el contenido de las carpetas 
del dispositivo. La carpeta raíz se denomina My Device (Mi dispositivo). 
Esta carpeta es parecida a la carpeta Mi PC del ordenador y contiene las 
carpetas Mis documentos, Archivos de programas, Temporal, Tarjeta de 
almacenamiento y Windows, entre otras. 

Para buscar un elemento:

1 Puntee en Programas→ Explorador de archivos. 
Aparecerá la carpeta Mis documentos y las correspondientes 
subcarpetas. 

2 Puntee en la lista de carpetas (etiquetada como Mis documentos de 
manera predeterminada) y en la carpeta que desee explorar. 

3 Para abrir un elemento, puntee en él. 

4 Si desea suprimir, renombrar o copiar un artículo rápidamente, puntee 
en él y mantenga el lápiz en esa posición. 

5 Para seleccionar varios elementos, puntee en la pantalla y deslice el 
lápiz sobre ellos. A continuación, puntee y mantenga seleccionados los 
elementos, y puntee en un comando. 
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Cómo conectarse
Puede utilizar el dispositivo para intercambiar información con otros 
dispositivos móviles o con un ordenador, una red o Internet. Puede utilizar 
cualquiera de las opciones de conexión siguientes:
• Utilice el puerto infrarrojos (IR) del dispositivo para enviar y recibir 

archivos entre dos dispositivos. Para obtener más información, consulte el 
apartado “Utilización de infrarrojos” a continuación.

• Conéctese a su proveedor de servicios de internet (ISP). Una vez que se 
haya conectado, podrá enviar y recibir mensajes de correo electrónico 
mediante Messaging (Mensajería) y ver páginas web o WAP mediante 
Internet Explorer Mobile. El software de comunicaciones para crear una 
conexión ISP ya viene instalado en el dispositivo. El proveedor de 
servicios proporciona el software necesario para instalar otros servicios, 
como los servicios de fax y de envío de señales de llamada.

• Conéctese a la red de la empresa u organización en la que trabaja. Una 
vez que esté conectado, podrá enviar y recibir mensajes de correo 
electrónico mediante Messaging (Mensajería), ver páginas web o WAP 
mediante Internet Explorer Mobile y sincronizarse con su ordenador. 

• Conéctese a su ordenador para sincronizarse de forma remota. Una vez 
que se haya conectado, puede sincronizar información como la contenida 
en Pocket Outlook. Para obtener más información, consulte la ayuda de 
Microsoft ActiveSync® en el ordenador o la ayuda para conexiones en el 
dispositivo.

Uso de WiFi (802.11b)
La tecnología WiFi proporciona al dispositivo acceso a la red WLAN (Red 
de área local inalámbrica). WiFi, que es la abreviatura de fidelidad 
inalámbrica, hace referencia a cualquier tipo de red 802.11, ya sea 802.11b, 
802.11a o de banda dual. Los productos certificados WiFi de diferentes 
fabricantes son compatibles. 

 NOTA: Las configuraciones media y alta del dispositivo Axim tienen la tecnología 
WiFi 802.11b integrada y los controladores instalados de fábrica. Para un 
dispositivo de configuración baja, debe adquirir la tarjeta 802.11b SD, insertarla 
en el dispositivo y cargar los controladores.
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 NOTA: La utilidad de cliente de red inalámbrica predeterminada para su 
dispositivo es Dell WLAN Utility (Utilidad WLAN Dell).  Los siguientes pasos de 
configuración son para Dell WLAN Utility (Utilidad WLAN Dell).

Configure la red inalámbrica para el dispositivo en uno de los siguientes casos:

• La tarjeta de red está configurada

• La red inalámbrica está difundiendo SSID 

• La red inalámbrica no está difundiendo SSID 

Si la tarjeta de red está configurada

Normalmente la tarjeta de red inalámbrica interna ya está configurada. 
Algunas veces, tiene que elegir la tarjeta de red. En las configuraciones de los 
dispositivos Axim X51/X51v que tienen la tecnología inalámbrica integrada, 
la tarjeta de red está asociada con la tecnología inalámbrica habilitada. Si la 
tecnología inalámbrica no está habilitada o si está utilizando la tarjeta de 
socket para la conexión inalámbrica, elija la tarjeta de red: 

1 Puntee en Inicio→ Configuración→ Connections (Conexiones).
2 Puntee en Network Cards (Tarjetas de red).
3 Elija Internet o Work (Trabajo) en el menú.
4 Elija la tarjeta de red para conectarse a la red. En el caso de los modelos 

Axim X51/X51v con tecnología inalámbrica integrada, elija el 
adaptador inalámbrico WLAN para los PDA Axim X51/X51v de Dell.

5 Elija si la tarjeta de red asigna una dirección IP o recibe una dirección 
IP de forma automática.

6 Escriba las direcciones IP del servidor, si es necesario, y puntee en OK 
(Aceptar).

Si la red inalámbrica está difundiendo SSID

1 Presione el botón inalámbrico para habilitar la capacidad de uso 
inalámbrico. El LED verde situado en el ángulo superior derecho del 
dispositivo indica que la tecnología inalámbrica es funcional. 

2 Puntee en Inicio→ Configuración→ Connections (Conexiones).
3 Para agregar, editar o suprimir un perfil, seleccione la acción 

correspondiente y puntee en Network Cards (Tarjetas de red).
4 En la ventana Configure Wireless Networks (Configurar redes 

inalámbricas), seleccione uno de los nombres de red disponibles y 
puntee en OK (Aceptar). 
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Si la red inalámbrica no está difundiendo SSID

La ventana Configure Wireless Networks (Configurar redes inalámbricas) 
sólo muestra las redes inalámbricas que difunden un Nombre de la red 
(SSID) y las que se han agregado. Agregue la red si no aparece en la lista. 
Póngase en contacto con el administrador de red para obtener la siguiente 
información: 
• SSID (nombre de la red) 
• Autenticación 
• Codificación de datos 
• Teclas (si la tecla no se proporciona automáticamente) 
• Inicie una sesión si es necesario 
Para configurar la red inalámbrica:

1 En la ventana Configure Wireless Networks (Configurar redes 
inalámbricas), puntee en Add New (Agregar nueva).

2 Proporcione el nombre de la red (SSID).
3 Seleccione Internet o Work (Trabajo) en el cuadro Connects To (Se 

conecta con). 
• Si selecciona Internet, podrá conectarse a la red, pero tendrá que 

iniciar manualmente una conexión VPN si es necesario. 
• Si selecciona Work (Trabajo), se inicia automáticamente una 

conexión VPN cada vez que se conecta a la red. 
• Si tiene problemas para conectarse a la red, cambie el cuadro 

Connects To (Se conecta con) a Internet. 
4 Puntee la ficha Network Key (Clave de red).
5 Escriba la información de Authentication (Autenticación) y Data 

Encryption (Codificación de datos). Si es necesaria una clave, escriba 
la clave de red.

6 Seleccione la ficha 802.1x.
7 La autenticación y la codificación de datos elegidos en la pantalla 

anterior determinan si esta pantalla está disponible. Si está disponible, 
elija el tipo EAP que se utiliza en la red.

8 Puntee en OK (Aceptar).
9 Si se lista más de una red, mantenga pulsado el lápiz sobre el nombre 

de la red a la que desea conectarse. Aparece un menú emergente. 
Puntee en Connect (Conectar). En unos segundos, debería ver 
Connected (Conectado) al lado de la red inalámbrica que seleccionó.
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Utilización de Odyssey Client
Odyssey es una solución de seguridad y control de acceso LAN inalámbrico 
que proporciona una seguridad fuerte al enlace inalámbrico. Asegura la 
autenticación y la conexión de los usuarios de la red LAN inalámbrica 
(WLAN), y garantiza que sólo se pueden conectar los usuarios autorizados.

La solución Odyssey suele utilizarse en lugar del cliente de red 
inalámbrica del fabricante, como Dell WLAN Utility (Utilidad WLAN 
Dell), Intel ProSET o Zero Config Service de Windows XP. 

Para utilizar Odyssey:

• Puntee en Inicio→ Configuración→ ficha Connections→ Odyssey 
Client (Conexiones→ Cliente Odyssey).
La página principal muestra la siguiente información: 

• Estado de Odyssey

• Nombre de la red (SSID)

• Punto de acceso MAC 

• Información del paquete

• Para habilitar Odyssey Client (Cliente Odyssey), puntee en 
Configuración→ Enable Odyssey (Habilitar Odyssey).

• Para configurar un perfil inalámbrico, puntee en Configuración→ 
Configure (Configurar).Esto le proporciona una lista de perfiles 
existentes y le permite agregar, editar o suprimir perfiles. 

Adición de una red

Para agregar un perfil nuevo:

1 Puntee en Configuración→ Configure→ Add (Configurar→ Agregar). 
Aparece la ventana Add Network Wizard (Agregar asistente de red). 

2 Escriba el nombre de la red o seleccione el cuadro Any (Cualquiera) si 
desea que el cliente se conecte a cualquier red disponible. 

3 Puntee en Scan (Explorar) para ver todas las redes difundidas 
disponibles.
Escriba una descripción si es necesario. 

4 Elija una red ad-hoc o de infraestructura. 

5 Puntee en Next (Siguiente) cuando esté preparado.
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6 Escriba los valores de seguridad:

• Association Mode (Modo de asociación) admite métodos de 
asociación abiertos, compartidos o WPA. 

• Encryption Method (Método de codificación) cambia en función 
del modo que se elija. Las opciones son Ninguno, WEP y TKIP.

• SI se utiliza 802.1x, seleccione el cuadro Authenticate using 
802.1X (Autenticar con 802.1X). 

• Para WPA-PSK, escriba su frase de acceso (clave). 

7 En función de su selección, aparece la siguiente página. Puede que se le 
solicite que escriba una clave WEP o un nombre de usuario y contraseña. 

8 Puntee en Next (Siguiente). 

9 Aquí puede seleccionar (Protocolo de autenticación extensible). Los 
valores predeterminados sólo incluyen EAP/TTLS. 

a Si necesita otros métodos EAP, puntee en Add (Agregar).

b Después de agregar otros métodos EAP, puntee en OK 

c Puntee en Next (Siguiente).

10 Escriba un nombre anónimo de modo que su nombre de inicio de 
sesión sea privado. Este nombre se utilizará para la autenticación 
visible externa. Puntee en Next (Siguiente).

11 En función del método EAP que elija, seleccione un protocolo de 
autenticación interior. Puntee en Next (Siguiente).

12 Escriba el nombre de usuario y la contraseña y puntee en Next 
(Siguiente).

13 Puntee en Finish (Terminar)

14 Cuando haya terminado, el nuevo perfil se agrega a las redes que puede 
elegir. Para seleccionar el perfil al que desea conectarse, puntee en OK 
(Aceptar), en el ángulo superior derecho. 

15 Cuando vuelva a la página Today (Hoy), habrá un nuevo icono en la 
bandeja del sistema para Odyssey. 
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Cómo utilizar la seguridad LAN inalámbrica 
Cisco® LEAP
El dispositivo Axim X51/X51v de Dell soporta la autenticación de red 
802.1x entre el cliente y el servidor con una contraseña de inicio de sesión 
mediante Cisco LEAP. 

Cisco LEAP puede configurarse utilizando la aplicación Odyssey Client.

 NOTA: Antes de empezar, asegúrese de que la alimentación inalámbrica está 
habilitada mediante el botón Act./Desac. inalámbrico.

 NOTA: LEAP no se admite en una red paritaria. LEAP no se admite en una 
configuración baja del modelo Axim X51.

Para iniciar Odyssey Client:

1 Puntee en Start (Inicio)→ Settings (Configuración)→ Connections 
(Conexiones)→ el icono Odyssey Client.

2 Puntee en Settings (Configuración)→ Enable Odyssey (Habilitar 
Odyssey).

Para empezar a utilizar LEAP:
1 Obtenga la siguiente información de su administrador de red:

• Nombre de red
• Modo de asociación
• Método de codificación

2 En la ventana Odyssey Client (Cliente Odyssey), puntee en Settings→ 
Configure→ Add (Configuración→ Configurar→ Agregar).

3 Introduzca el nombre de la red (SSID), si se conoce, o puntee en Scan 
(Explorar) para buscar los puntos de acceso disponibles. Puntee en 
Next (Siguiente).

4 LEAP solamente admitirá una red de infraestructura, por lo que no 
tiene que cambiar la configuración predeterminada del menú 
descendente. Puntee en Next (Siguiente).

5 Rellene el campo del método Association Mode and Encryption 
(Modo de asociación y codificación). Puntee en Next (Siguiente).

6 EAP/TTLS es el tipo EAP predeterminado. Puntee en Add (Agregar) y 
seleccione EAP/LEAP en la ventana que se abre.
A no ser que tenga un certificado de autenticación para utilizar TTLS y 
haya configurado su sistema para admitirlo, elimine EAP/TTLS. 
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 NOTA: Si no se elimina EAP/TTLS cuando no haya sido configurado 
adecuadamente, podría impedir el funcionamiento del sistema de 
seguridad inalámbrico.

7 Puntee en Next (Siguiente).
8 Introduzca su nombre de usuario y contraseña. Puntee en Next 

(Siguiente).
9 Puntee en Finish (Terminar) para terminar la configuración de LEAP.

10 Puntee en OK (Aceptar).
11 Seleccione la red que agregó desde el menú descendente y puntee en el 

cuadro situado al lado de Connect to (Conectar a). El estado se mostrará 
como conectado (autenticado) cuando el proceso haya terminado.

 NOTA: Para obtener más detalles al respecto, consulte el archivo de ayuda de 

Odyssey Client incluido con su dispositivo. Puede acceder al archivo de ayuda en 

Start (Inicio)→ Help (Ayuda)→ Odyssey Client for Pocket PC (Odyssey Client para 

Pocket PC), o puntee en Help (Ayuda) en la pantalla principal de Odyssey Client.

Utilización de Odyssey Client para obtener un 
certificado de autoridad
Hay dos formas de obtener certificados en el cliente Odyssey.
• Mediante Certificate Enroller (Suscriptor de certificados)
• Mediante la opción Import User Certificate (Importar certificado de 

usuario)
Utilice Certificate Enroller (Suscriptor de certificados) para instalar un 
certificado de usuario mediante Microsoft Certificate Services (Servicios 
de certificados de Microsoft). Utilice la opción Import User Certificate 
(Importar certificado de usuario) para instalar el archivo del certificado 
.pfx almacenado en el dispositivo. Para decidirse por un tipo de 
certificado, consulte a su administrador de red.
Para utilizar Certificate Enroller (Suscriptor de certificados):

1 Utilice el cliente Odyssey para conectarse a una red inalámbrica 
habilitada que no sea 802.1x en la que se encuentre el servidor de 
certificados.

2 Puntee Inicio→ Configuración→ Connections→ Odyssey Client 
(Conexiones→ Cliente Odyssey).

3 Puntee en Tools→ Certificate Enroller (Herramientas→ Suscriptor de 
certificados).
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4 Escriba la dirección IP del servidor de certificados en el campo Server 
(Servidor).

5 Escriba el nombre de usuario y el nombre de dominio en el campo User 
name (Nombre de usuario) utilizando la siguiente regla:
Nombre de dominio\Nombre de usuario

6 Puntee en Request (Solicitar).
Para utilizar Import User Certificate (Importar certificado de usuario):

 NOTA: Antes de instalar un certificado, debe saber la contraseña de clave 
privada de tipo RSA.

1 Puntee Inicio→ Configuración→ Connections→ Odyssey Client 
(Conexiones→ Cliente Odyssey).

2 Puntee en Tools→ Import User Certificate (Herramientas→ Importar 
certificado de usuario).

3 Puntee en Browse (Examinar) para ir al archivo .pfx que almacenó en 
el dispositivo. Seleccione el archivo y puntee en OK (Aceptar). 

4 Escriba la contraseña de clave privada de tipo RSA para este certificado 
en Private key password (Contraseña de clave privada). También puede 
hacer clic en Unmask (Desenmascarar) para poder ver la contraseña 
mientras la escribe.

5 Puntee en Install Certificate (Instalar certificado) cuando haya 
terminado.

Utilización de infrarrojos
Los infrarrojos se utilizan para enviar y recibir información de forma 
remota, como contacto y citas, entre dos dispositivos.

Para enviar información:

1 Vaya al programa en el que ha creado el elemento que desea enviar y 
localice el elemento en la lista.

2 Alinee los sensores infrarrojos de modo que no estén obstruidos y que 
se encuentren dentro de un rango cercano.

3 Puntee y mantenga marcado el elemento, y puntee en Beam xxxx 
(Transferir xxxx) en el menú emergente, donde xxxx es el elemento 
que desea emitir.

También es posible enviar elementos (salvo carpetas) desde el Explorador 
de archivos. Puntee y mantenga el lápiz en el artículo que desea enviar y, a 
continuación, puntee en Beam File (Emitir archivo) en el menú emergente.
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Utilización de la tecnología inalámbrica 
Bluetooth®

Bluetooth es una tecnología inalámbrica que tiene como objetivo simplificar 
las comunicaciones entre los dispositivos e Internet. Es una especificación 
abierta para la comunicación de corto alcance de datos y voz. Por ejemplo, 
puede sincronizar datos entre dispositivos de bolsillo y otros ordenadores.

Perfiles Bluetooth compatibles: 

• Acceso genérico 

• Aplicación de detección de servicio

• Puerto serie

• Sistema de red de conexión telefónica para el intercambio de objetos 
genéricos

• Objeto PUSH

• HID

Para configurar un dispositivo con tecnología inalámbrica Bluetooth en un 
entorno de Pocket PC:

1 Asegúrese de que los dos dispositivos están activados, identificable y en 
un rango cercano.

2 Puntee en Inicio→ Configuración→ ficha Connections (Conexiones). 

3 Puntee en Bluetooth→ ficha Devices (Dispositivos)→ New Partnership 
(Nueva asociación). El dispositivo busca otros dispositivos Bluetooth y 
los muestra en la lista. 

4 Puntee en el nombre de otro dispositivo y en Next (Siguiente). 

5 En el campo Passkey (Clave de acceso), si desea utilizar una clave de 
acceso (recomendado para una mayor seguridad), escriba una clave de 
acceso alfanumérica que tenga entre 1 y 16 caracteres y puntee en Next 
(Siguiente). Si no, deje el campo Passkey (Clave de acceso) en blanco y 
puntee en Next (Siguiente). 

 NOTA: La clave de acceso para un dispositivo Bluetooth remoto suele estar en 
el manual de usuario del dispositivo. La clave de acceso predeterminada para 
cualquier dispositivo Axim de Dell es 1234.

6 Escriba la misma clave de acceso para otro dispositivo. 

7 Puntee en Finish (Terminar).
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Se crea una conexión activa con la tecnología inalámbrica Bluetooth y 
se completa el emparejamiento de los dos dispositivos. 

 NOTA: Para obtener más información sobre la utilización de la tecnología 
inalámbrica Bluetooth, puntee en Inicio→ Ayuda→ Setting Up Connections 
(Configuración de conexiones).

Creación de una conexión de módem
Para crear una conexión de módem:

1 Instale una tarjeta de módem y los adaptadores adecuados para 
conectar un módem externo a su dispositivo a través del puerto serie.

2 Obtenga la siguiente información de su ISP: 

• Número de teléfono para acceso telefónico del ISP

• Nombre de usuario y contraseña

• Configuración de TCP/IP

Algunos proveedores de servicios de internet (ISP) requieren que una 
información determinada preceda el nombre de usuario, por ejemplo, 
MSN/nombre de usuario.

3 Puntee en Inicio→ Configuración→ ficha Connections 
(Conexiones)→ Connections (Conexiones).

4 En My ISP (Mi ISP) o My Work Network (Mi red de trabajo), puntee 
en Add a new modem connection (Agregar nueva conexión de módem).

5 Introduzca un nombre para la conexión, como por ejemplo, ISP 
Connection (Conexión de ISP).

6 En la lista Select a modem (Seleccione un módem), elija su tipo de 
módem y puntee en Next (Siguiente).

Si su tipo de módem no aparece en la lista, vuelva a insertar la tarjeta 
de módem. Si utiliza un módem externo conectado a su dispositivo 
con un cable, seleccione Hayes Compatible on COM1 (Compatible 
con Hayes en COM1). Consulte la guía de usuario del módem para 
obtener información detalle.

7 Escriba el número de teléfono tal y como se debe marcar. Si necesita un 
prefijo, inclúyalo. Puntee en Next (Siguiente).
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8 Escriba su nombre de usuario, contraseña y dominio (si procede). 
Esta información la proporciona el proveedor de servicios de Internet 
(ISP) o el administrador de red.

 NOTA: No es necesario cambiar ningún valor en Advanced (Avanzada). La 
mayoría de los proveedores de Internet de hoy utilizan una dirección asignada 
de forma dinámica.

9 Si el ISP al que se está conectando no utiliza una dirección asignada 
dinámicamente, puntee en Advanced (Avanzada), en la ficha TCP/IP 
y, a continuación, escriba la dirección. 

10 Puntee en OK (Aceptar).

11 Seleccione las demás opciones necesarias y puntee en Finish (Terminar).

Cuando abra Messaging (Mensajería), Internet Explorer Mobile o MSN 
Messenger, el dispositivo se conectará automáticamente. Una vez que se 
haya conectado, puede:

• Enviar y recibir mensajes de correo electrónico mediante Messaging 
Antes de utilizar Messaging (Mensajería), debe proporcionar la 
información que necesita Messaging (Mensajería) para comunicarse 
con el servidor de correo electrónico. Consulte el apartado “Conexión 
directa con un servidor de correo electrónico” en la página 107 para 
obtener más información.

• Consulte las páginas web y WAP utilizando Internet Explorer Mobile. 
Para obtener más información, consulte el apartado “Utilización de 
Internet Explorer Mobile” en la página 121.

• Enviar y recibir mensajes instantáneos mediante MSN Messenger. Para 
obtener más información, consulte el apartado “MSN Messenger” en la 
página 119.

Creación de una conexión Ethernet
El término Ethernet hace referencia a la familia de productos LAN que 
cubre el estándar IEEE 802.3. Define lo que normalmente se conoce 
como protocolo CSMA/CD. 
Para crear una conexión Ethernet:

1 Póngase en contacto con su administrador de red para obtener un 
nombre de usuario, una contraseña y un nombre de dominio.

2 Instale el controlador de tarjeta de red, si es necesario. Para obtener más 
información, consulte la documentación incluida con la tarjeta de red.
Cómo conectarse 105



3 La ventana Network Settings (Configuración de red) aparece 
automáticamente la primera vez que inserta la tarjeta de red para que la 
configure. Para cambiar la configuración más tarde, puntee en Inicio→ 
Configuración→ ficha Connection (Conexión)→ Connections 
(Conexiones).

4 Si necesita introducir información de un servidor específico, puntee en 
el adaptador adecuado y, a continuación, puntee en Properties 
(Propiedades). Es posible que deba introducir los valores de conexión 
VPN y el servidor proxy. Para obtener más información, consulte al 
administrador de red.

 NOTA: La mayoría de las redes utilizan el protocolo DHCP (protocolo de 
configuración dinámica del host), así que no es necesario cambiar la 
configuración de conexión a menos que el administrador de red le indique 
que lo haga.

5 Si es necesario, conecte la tarjeta de red a la red mediante un cable de 
red. Para obtener más información, consulte la documentación incluida 
con la tarjeta de red.

Creación de una conexión VPN
Una red privada virtual (VPN) se construye utilizando cables públicos para 
conectar los nodos. Estos sistemas utilizan la codificación y otros 
mecanismos de seguridad para garantizar que sólo pueden acceder a la red 
los usuarios autorizados y que no se puede interceptar lo datos. 

1 Puntee en Inicio→ Configuración→ ficha Connections (Conexiones)→ 
Connections (Conexiones).

2 Puntee en Add a new VPN server connection (Agregar nueva conexión 
de servidor VPN).

 NOTA: Si ya ha creado un servidor VPN, puntee en Edit My VPN Servers 
(Editar mis servidores VPN) y, a continuación, en New (Nuevo).

3 Escriba un nombre para la conexión.

4 En el campo Host name/IP (Nombre del host o dirección IP), escriba el 
nombre del servidor VPN o la dirección IP. El administrador de red le 
facilitará esta información.

5 En función del tipo de autenticación que desee utilizar con el 
dispositivo, puntee en IPSec o en PPTP, situados al lado de VPN type 
(Tipo de VPN). 
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Si no está seguro de la opción que desea seleccionar, póngase en 
contacto con el administrador de red.

6 Puntee en Next (Siguiente) y escriba el nombre de usuario, la 
contraseña y, si es necesario, el dominio.

7 Instale el controlador de tarjeta de red, si es necesario. Para obtener más 
información, consulte la documentación incluida con la tarjeta de red.

8 Puntee en Finish (Terminar).

9 Para iniciar manualmente una conexión, mantenga punteada la 
conexión y puntee en Connect (Conectar).

 NOTA: Una conexión VPN requiere una conexión física a una red. 
Asegúrese de que la unidad está vinculada a una red, inalámbrica o no, 
antes de iniciar manualmente una conexión VPN.

Finalización de una conexión
Para desconectarse:

• Para suprimir una conexión, mantenga punteada la conexión que desea 
retirar y puntee en Delete (Suprimir). 

• Cuando esté conectado por medio de un cable o una base, desconecte 
el dispositivo del cable o la base. 

• Cuando esté conectado por medio del sensor de infrarrojos, aleje el 
dispositivo del ordenador. 

• Cuando esté conectado por medio de una tarjeta de red (Ethernet), 
extraiga la tarjeta del dispositivo. 

Conexión directa con un servidor de correo 
electrónico
Puede establecer una conexión con un servidor de correo electrónico para 
poder enviar y recibir mensajes de correo electrónico mediante un módem 
o una conexión de red y mediante el programa Messaging (Mensajería) del 
dispositivo.

 NOTA: El ISP o la red deben utilizar un servidor de correo electrónico tipo 
POP3 o IMAP4 y una puerta de enlace de SNTP.
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Dispone de varios servicios de correo electrónico para recibir mensajes. Por 
cada servicio de correo electrónico que quiera utilizar, primero debe 
configurar el servicio de correo electrónico y asignarle un nombre. Si desea 
utilizar el mismo servicio para conectarse a distintos buzones, configure 
cada una de las conexiones de buzón y asígneles un nombre.

Para configurar un servicio de correo electrónico:

1 En la opción Messaging (Mensajería) de su dispositivo, puntee en 
Accounts→ New Account (Cuentas→ Cuenta nueva). 

2 Siga las indicaciones del asistente de configuración de correo electrónico.

Para obtener más información, puntee en Inicio→ Ayuda. 

Para conectarse al servidor de correo electrónico, puntee en Account→ 
Connect (Cuenta→ Conectar). Para obtener más información sobre cómo 
utilizar el programa Messaging (Mensajería), consulte el apartado 
“Messaging (Mensajería)” en la página 88.

Obtención de ayuda sobre la conexión
Para obtener más información sobre cómo conectarse, consulte los 
recursos siguientes:

• “Messaging (Mensajería)” en la página 88.

• La ayuda en línea del dispositivo. Puntee en Inicio→ Ayuda. Puntee en 
Messaging (Mensajería) o Connections (Conexiones).

• La ayuda de ActiveSync en el ordenador. En ActiveSync, haga clic en 
Ayuda→ Ayuda de Microsoft ActiveSync.

• Consulte www.microsoft.com/windowsmobile para obtener 
información sobre la solución de problemas.
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Adición y eliminación de programas
Algunos programas ya estaban instalados en la memoria ROM cuando 
recibió el dispositivo. Estos programas no se pueden eliminar, ni se puede 
perder el contenido de la ROM accidentalmente. Puede actualizar los 
programas de la ROM mediante los programas de instalación con la 
extensión *.pku. Puede guardar los datos en Flash ROM. 

Puede instalar cualquier programa creado para el dispositivo siempre y 
cuando éste tenga suficiente memoria. El lugar más habitual para encontrar 
software para el dispositivo es el sitio web de software Microsoft® Windows 
Mobile™ Versión 5.0 para Pocket PC Premium Edition: 
www.microsoft.com/windowsmobile.

Adición de programas con Microsoft® 
ActiveSync®

Antes de instalar software en el dispositivo, debe instalar ActiveSync en el 
ordenador. Para obtener más información, consulte la Ayuda de ActiveSync 
en el ordenador.

 NOTA: Los clientes deben tenerla versión ActiveSync 4.0 o posterior antes de usar 
Axim. ActiveSync 4.0 o posterior está disponible en el CD de inicio. Para obtener 
más ayuda sobre ActiveSync, visite el siguiente sitio web: 
http://www.microsoft.com/windowsmobile/help/activesync/default.mspx

1 Determine el tipo de dispositivo y de procesador para saber qué versión 
del software debe instalar:

a Puntee en Inicio→ Configuración. 

b En la ficha Sistema, puntee en Acerca de. 

c En la ficha Versión, registre la información del procesador. 
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2 Descargue el software en el ordenador (o inserte el CD o disquete de 
inicio que contiene el software en el ordenador). Es posible que vea un 
solo archivo *.exe o *.zip, un archivo Setup.exe o varias versiones de 
archivos para distintos tipos de dispositivos y procesadores. Asegúrese 
de seleccionar el programa diseñado para Pocket PC y el tipo de 
procesador del dispositivo.

3 Lea las instrucciones de instalación, los archivos Léame o la 
documentación que se incluyen con el programa. Muchos programas 
proporcionan instrucciones especiales de instalación. 

4 Conecte el dispositivo a un ordenador para:

5 Pulse dos veces en el archivo *.exe.

Si el archivo es un archivo instalador, se iniciará el asistente de 
instalación. Siga las instrucciones que aparecen en la pantalla. Una vez 
que haya instalado el software en el ordenador, el programa de 
instalación transferirá automáticamente el software al dispositivo. 

Si el archivo no es un archivo instalador, recibirá un mensaje de error 
que le informará de que el programa es válido, pero que está diseñado 
para un tipo de ordenador distinto. Deberá mover dicho archivo al 
dispositivo. Si no puede encontrar las instrucciones de instalación para 
el programa en el archivo Léame ni en la documentación, utilice el 
explorador de ActiveSync para copiar el archivo de programa en la 
carpeta Archivos de programa del dispositivo. Para obtener más 
información sobre cómo copiar archivos mediante ActiveSync, consulte 
la Ayuda de ActiveSync en el ordenador. 

Para abrir un programa una vez finalizada la instalación, puntee en 
Inicio→ Programas y, a continuación, puntee en el icono del programa.

Descarga de programas de Internet
1 Determine el tipo de dispositivo y de procesador para saber qué versión 

del software debe instalar:

a Puntee en Inicio→ Configuración. 

b En la ficha Sistema, puntee en Acerca de. 

c En la ficha Versión, registre la información del procesador. 
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2 Utilice Internet Explorer Mobile para descargar el programa en el 
dispositivo. Es posible que vea un solo archivo *.exe o *.zip, un archivo 
Setup.exe o varias versiones de archivos para distintos tipos de 
dispositivos y procesadores. Asegúrese de seleccionar el programa 
diseñado para Pocket PC y el tipo de procesador del dispositivo.

3 Lea las instrucciones de instalación, los archivos Léame o la 
documentación que se incluyen con el programa. Muchos programas 
proporcionan instrucciones especiales de instalación.

4 Puntee en el archivo, por ejemplo, en el archivo *.exe. 

Se inicia el asistente de instalación. Siga las instrucciones que aparecen 
en la pantalla.

Adición de un programa al menú Inicio
1 Puntee en Inicio→ Configuración.

2 Puntee en Menus (Menús) y, a continuación, en la casilla de 
verificación para el programa.

Si el programa no aparece en la lista, puede utilizar el Explorador de 
archivos del dispositivo para mover el programa a la carpeta Start 
Menu (Menú Inicio), o bien utilizar ActiveSync en el ordenador para 
crear un acceso directo al programa mediante los siguientes pasos:

a Utilice el explorador en ActiveSync para examinar los archivos del 
dispositivo y localizar el programa. 

b Pulse el botón derecho del ratón en el programa y, a continuación, 
pulse Crear acceso directo. 

c Mueva el acceso directo a la carpeta Menú Inicio de la carpeta 
Windows. El acceso directo aparece ahora en el menú Inicio. Para 
obtener más información, consulte la Ayuda de ActiveSync en el 
ordenador.
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Eliminación de programas
1 Puntee en Inicio→ Configuración. 

2 Puntee en System→ Remove Programs (Sistema→ Eliminar 
programas).

3 Mantenga punteado el nombre del programa y, a continuación, puntee 
en Delete (Suprimir) en el menú emergente. 
Si el programa no figura en la lista de programas instalados, utilice el 
Explorador de archivos del dispositivo para localizar el programa.
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Uso de los programas de 

complemento
Entre los programas de complemento se incluyen Word Mobile, Excel 
Mobile, PowerPoint Mobile y Windows Media Player para Pocket PC. 

Para utilizar un programa de complemento en su dispositivo, puntee en 
Inicio→ Programas y, a continuación, puntee en el nombre del programa.

 NOTA:  Antes de conectar el dispositivo a un ordenador por primera vez, instale 
ActiveSync en el ordenador con el CD de inicio de Dell™.

Word Mobile
Word Mobile funciona con Microsoft Word en el ordenador para permitir 
un fácil acceso a las copias de los documentos. Puede crear documentos 
nuevos en el dispositivo, o puede copiar documentos del ordenador en el 
dispositivo. Sincronice los documentos entre el ordenador y el dispositivo 
para tener el contenido más actualizado en ambas ubicaciones.

Utilice Word Mobile para crear documentos, como cartas, actas de 
reuniones e informes de viajes. 

Para crear un nuevo archivo:

1 Puntee en Inicio→ Programas→ Word Mobile.

2 Puntee en Nuevo. 

Aparece un documento en blanco. O bien, si ha seleccionado una 
plantilla para los nuevos documentos en el cuadro de diálogo Opciones, 
aparecerá la plantilla con el texto y formato predefinidos. 
Uso de los programas de complemento 113



Sólo puede abrir un documento a la vez. Si abre un segundo documento, 
se le pedirá que guarde el primero. Se puede crear, guardar o editar un 
documento en varios formatos, como por ejemplo Word (.doc), plantilla 
de Word (.dot), formato de texto enriquecido (.rtf) y sólo texto (.txt). 
Word Mobile contiene una lista de los archivos almacenados en el 
dispositivo. Puntee en un archivo de la lista para abrirlo. Para eliminar, 
copiar o enviar archivos, puntee y mantenga el lápiz en un archivo de la 
lista. A continuación, seleccione la acción apropiada en el menú emergente.

Puede introducir información en Word Mobile tecleando, escribiendo, 
dibujando o grabando. Estos modos aparecen en el menú View (Ver). 
Cada modo tiene su propia barra de herramientas, la cual se puede 
mostrar y ocultar punteando en el icono Show/Hide Toolbar (Mostrar u 
ocultar barra) en la barra de comandos.
Para cambiar la ampliación del zoom, puntee en View→ Zoom (Ver→
Zoom) y, a continuación, seleccione el porcentaje deseado. Seleccione un 
porcentaje más alto para introducir texto y un porcentaje más bajo para 
obtener una visión más amplia del documento.

Barra de 
herramientas 
de formato

Icono del panel de entrada
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Si desea abrir un documento de Word creado en un ordenador, seleccione 
Wrap to Window (Ajustar a la ventana) en el menú View (Ver), para poder 
ver el documento completo.

Excel Mobile 
Excel Mobile trabaja con Microsoft Excel en el ordenador para permitir un 
fácil acceso a copias de los libros. Puede crear libros nuevos en el dispositivo, 
o puede copiar libros del ordenador en el dispositivo. Sincronice los libros 
entre el ordenador y el dispositivo para tener el contenido más actualizado 
en ambas ubicaciones.

Utilice Excel Mobile para crear libros, como informes de gastos y registros 
de kilometraje. 

Para crear un nuevo archivo:

1 Puntee en Inicio→ Programas→ Excel Mobile.

2 Puntee en Nuevo. 

Aparece un libro en blanco. O bien, si ha seleccionado una plantilla 
para los nuevos libros en el cuadro de diálogo Opciones, aparecerá la 
plantilla con las fórmulas y el formato predefinidos.
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Sólo puede abrir un libro a la vez. Si abre un segundo libro, se le pedirá 
que guarde el primero. Se puede crear, guardar o editar un libro en varios 
formatos, como por ejemplo la plantilla de Excel (.xlt) y Excel (.xls).

Excel Mobile contiene una lista de los archivos almacenados en el 
dispositivo. Puntee en un archivo de la lista para abrirlo. Para eliminar, 
copiar o enviar archivos, puntee y mantenga el lápiz en un archivo de la 
lista. A continuación, seleccione la acción apropiada en el menú emergente.

Excel Mobile proporciona herramientas básicas para las hojas de cálculo, 
como fórmulas, funciones, funciones para ordenar y para filtrar. Para 
mostrar la barra de herramientas, puntee en View→ Toolbar (Ver→ Barra 
de herramientas. 

Barra de 
herramientas 
de formato
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Consejos para utilizar Excel Mobile

Utilice los siguientes consejos cuando trabaje con libros grandes en Excel 
Mobile:

• Utilice la pantalla completa: Puntee en View→ Full Screen (Ver→ 
Pantalla completa) para obtener una vista del libro lo más completa 
posible. Para salir del modo de pantalla completa, puntee en Restore 
(Restaurar).

• Muestre y oculte elementos de la ventana: Puntee en View (Ver) y, a 
continuación, en los elementos que desee mostrar u ocultar.

• Inmovilice las secciones de un libro: Seleccione la celda en la que desea 
inmovilizar las secciones. Puntee en View→ Freeze Panes (Ver→ 
Inmovilizar secciones). Puede ser que desee inmovilizar las secciones 
superior y del extremo izquierdo de un libro para mantener visibles las 
etiquetas de las filas y columnas mientras se desplaza por una hoja.

• Divida las secciones para ver distintas áreas de una hoja de cálculo grande. 
Puntee en View→ Split (Ver→ Dividir). Arrastre la barra de división al 
lugar que desee. Para eliminar la división, puntee en View→ Remove 
Split (Ver→ Quitar división).

• Muestre y oculte filas y columnas: Para ocultar una fila o columna, 
seleccione una celda de la fila o columna que desee ocultar. Puntee en 
Menu→ Format→ Row o Column→ Hide (Menú→ Formato→ Fila o 
Columna) Para mostrar una fila o una columna oculta, puntee en 
Menu→ Edit→ Go (Menú→ Editar→ Ir) y, a continuación, escriba 
una referencia de la fila o la columna oculta. A continuación, puntee en 
Menu→ Format→ Row o Column→ Unhide (Menú→ Formato→ 
Fila o Columna→ Mostrar).

Para obtener más información sobre el uso de Excel Mobile, puntee en 
Inicio→ Help (Ayuda).

PowerPoint Mobile
PowerPoint Mobile trabaja con Microsoft PowerPoint en el ordenador para 
ofrecerle un acceso sencillo a las copias de sus diapositivas de 
presentación. Muchos de los elementos de presentación incorporados a las 
presentaciones, como las transiciones de diapositivas y las animaciones, se 
reproducirán en el dispositivo. Si la presentación está configurada como 
una presentación cronometrada, una diapositiva llevará a la otra de 
manera automática. También se admiten los vínculos con las URL.
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Entre las funciones de PowerPoint no compatibles con el dispositivo se 
incluyen: 

• Notas: las notas escritas para las diapositivas no se verán. 

• Reorganización o edición de las diapositivas: PowerPoint Mobile es 
sólo un visor. 

Para iniciar una presentación:

1 Puntee en Inicio→ Programas→ PowerPoint Mobile. 

2 En la lista de presentaciones, puntee en la presentación que desee ver. 

3 Puntee la diapositiva actual para pasar a la siguiente diapositiva. 
Si la presentación está configurada como una presentación 
cronometrada, las diapositivas pasarán automáticamente. 

Sólo puede abrir un documento a la vez. Si abre otro documento, se le 
pedirá que guarde y cierre la primera. Puede ver un documento en varios 
formatos, incluidos PowerPoint (.ppt) y PowerPoint Mobile (.pps). 

PowerPoint Mobile contiene una lista de los archivos almacenados en el 
dispositivo. Puntee en un archivo de la lista para abrirlo. Para eliminar, copiar 
o enviar archivos, puntee y mantenga el lápiz en un archivo de la lista. A 
continuación, seleccione la acción apropiada en el menú emergente.
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MSN Messenger
Con el programa de mensajes instantáneos MSN Messenger, puede:
• Ver quién está en línea.
• Enviar y recibir mensajes instantáneos.
• Mantener conversaciones de mensajes instantáneos con grupos de 

contactos.
Para utilizar MSN Messenger, debe tener una cuenta de Microsoft 
Passport o una cuenta de correo electrónico de Microsoft Exchange. Debe 
tener una cuenta de Passport para utilizar el servicio MSN Messenger. Si 
tiene una cuenta de Hotmail o MSN, ya tiene una cuenta de Passport. Una 
vez que haya obtenido una cuenta de Microsoft Passport o de Microsoft 
Exchange, ya estará listo para configurar su cuenta.

 NOTA: Regístrese para obtener una cuenta de Microsoft Passport en la 
dirección www.passport.com. Obtenga una dirección de correo electrónico de 
Microsoft Hotmail gratis en la dirección www.hotmail.com.

Para cambiar a MSN Messenger, puntee en Inicio→ Programas→ Pocket 
MSN→ MSNMessenger.

 NOTA: La disponibilidad de MSN Messenger está sujeta a la base de idiomas.

Configuración 

Para poder conectarse, debe introducir la información de la cuenta de 
Passport o Exchange.
Para configurar una cuenta e iniciar sesión:

1 Puntee en Inicio→ Programas→ Pocket MSN→ MSN Messenger.
2 Puntee en Menu→ Options (Menú→ Opciones).
3 Introduzca su contraseña o intercambie información de la cuenta.
4 Para iniciar sesión, puntee en la pantalla de inicio de sesión e 

introduzca su dirección de correo electrónico y contraseña.

Cómo trabajar con contactos

La ventana de MSN Messenger muestra todos los contactos de Messenger 
en una sola pantalla, divididos en las categorías En línea y Sin conexión. 
Desde esta vista, mientras esté conectado, puede conversar, enviar 
mensajes de correo electrónico, bloquear un contacto para que no converse 
con usted o eliminar contactos de su lista utilizando el menú emergente.

 NOTA: Si ya utiliza MSN Messenger en el ordenador, sus contactos 
aparecerán en el dispositivo sin que tenga que agregarlos.
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Para ver quién está en línea sin que ellos le vean, puntee en Menú→ Mi 
estado→ No conectado.

Si bloquea un contacto, usted aparecerá sin conexión pero permanecerá 
en la lista de contactos bloqueados. Para desbloquear un contacto, puntee 
y mantenga el lápiz en el contacto y, a continuación, puntee en 
Desbloquear en el menú emergente.

Conversación con los contactos

• Puntee en el nombre de un contacto para abrir una ventana de 
conversación. Introduzca su mensaje en el área de entrada de texto 
situada en la parte inferior de la pantalla, o bien puntee en My Text 
(Mi texto) para introducir un mensaje predefinido, y luego puntee en 
Send (Enviar). 

• Para invitar a otro contacto a participar en una conversación de varios 
usuarios, puntee en Menu→ Chats→ Invite (Menú→ Conversaciones → 
Invitar) y, a continuación, puntee el contacto al que desea invitar.

• Para volver a la ventana principal sin cerrar una conversación, puntee 
en el icono Contactos. Para regresar a la ventana de conversación, 
puntee en Conversaciones y seleccione la persona con la que estaba 
conversando.

• Para saber si el contacto con el que está conversando está 
respondiendo, busque el mensaje debajo del área de entrada de texto.

Para obtener más información sobre el uso de MSN Messenger, puntee en 
Inicio→ Ayuda.

Microsoft Windows Media® Player para 
Pocket PC
Utilice Windows Media Player 10.0 para Pocket PC para reproducir 
archivos de audio y vídeo digital almacenados en el dispositivo o en una 
red. Para cambiar a Windows Media Player para Pocket PC, puntee en 
Inicio→ Windows Media.

Utilice Windows Media Player en el ordenador para copiar archivos de audio 
y vídeo digital en el Pocket PC. Puede reproducir Windows Media y archivos 
MP3 en el Pocket PC. Para obtener más información acerca del uso de 
Windows Media Player para Pocket PC, puntee en Inicio→ Help (Ayuda).
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Utilización de Internet Explorer Mobile
Utilice Internet Explorer Mobile para ver páginas web o WAP:

• Durante la sincronización con el ordenador, descargue sus vínculos 
favoritos y los favoritos móviles almacenados en la subcarpeta Favoritos 
móviles de Internet Explorer en el ordenador.

• Conéctese a un proveedor de servicios de Internet (ISP) o a una red para 
navegar por la web. Para obtener más información sobre cómo conectarse 
a Internet, consulte el apartado “Cómo conectarse” en la página 95.

Cuando el dispositivo esté conectado a un ISP o a una red, también puede 
descargar archivos y programas de Internet o la intranet.

Para utilizar Internet Explorer Mobile, puntee en Inicio→ Internet 
Explorer Mobile.

Favoritos móviles
Si utiliza Microsoft Internet Explorer 5.0 o superior en el ordenador, 
puede descargar favoritos móviles en el dispositivo. Cuando se sincronizan 
favoritos móviles, se descarga contenido de la web en el dispositivo para 
que pueda ver páginas mientras está desconectado del ISP y del 
ordenador. Utilice el complemento de Internet Explorer instalado con 
Microsoft ActiveSync® para crear favoritos móviles rápidamente.

Para crear un favorito móvil en el ordenador y descargarlo en el dispositivo:

1 En el ordenador, abra Internet Explorer y haga clic en Herramientas→ 
Create Mobile Favorite (Crear favoritos móviles).

2 Para cambiar el nombre del vínculo, introduzca un nuevo nombre en la 
casilla Nombre.

3 Especifique un programa de actualización junto a Actualizar (opcional).

4 Haga clic en Aceptar. 

Internet Explorer descargará la versión más reciente de la página en 
el ordenador.

5 En la aplicación Internet Explorer del ordenador, pulse el botón 
derecho del ratón en el favorito móvil y luego pulse Propiedades. 

6 En la ficha Download (Descargar), especifique el número de niveles 
hacia abajo que desea descargar. Para ahorrar memoria en el dispositivo, 
elija sólo un nivel hacia abajo.
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7 Sincronice el dispositivo y el ordenador. 

Los favoritos móviles que están almacenados en la carpeta Mobile 
Favorites (Favoritos móviles) en Internet Explorer se descargarán en el 
dispositivo.

Si no ha especificado un programa de actualización en el paso 3, deberá 
descargar manualmente el contenido para mantener la información 
actualizada en el ordenador y en el dispositivo. Antes de sincronizarse con el 
dispositivo, haga clic en Herramientas en Internet Explorer en el ordenador y 
haga clic en Synchronize (Sincronizar). La fecha de la columna 
Last Updated (Última actualización) corresponde a la última vez que se 
descargó contenido en el ordenador. Si es necesario, puede descargar 
manualmente el contenido.

 NOTA: puede agregar un icono en la barra de herramientas de Internet 
Explorer para crear favoritos móviles. En la aplicación Internet Explorer del 
ordenador, haga clic en Ver→ Barras de herramientas y, a continuación, haga 
clic en Personalizar.

Conservación de memoria

Los favoritos móviles ocupan memoria de almacenamiento en el 
dispositivo. Para minimizar la cantidad de memoria utilizada:

• Desactive las imágenes y los sonidos, o impida que se descarguen 
algunos favoritos móviles en el dispositivo mediante la configuración 
de Favoritos en las opciones de ActiveSync. Para obtener más 
información, consulte la Ayuda de ActiveSync en el ordenador.

• Limite el número de páginas vinculadas que pueden descargarse. En la 
aplicación Internet Explorer del ordenador, pulse el botón derecho del 
ratón en el favorito móvil que desee cambiar y luego pulse 
Propiedades. En la ficha Descargar, especifique 0 ó 1 para el número de 
páginas vinculadas que desee descargar.

Carpeta Favoritos móviles

Sólo se sincronizan con el dispositivo los elementos que están 
almacenados en la subcarpeta Favoritos móviles (en la carpeta Favoritos) 
de Internet Explorer en el ordenador. Esta carpeta se ha creado 
automáticamente durante la instalación de ActiveSync.
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Enlaces favoritos

Durante la sincronización, la lista de favoritos de la carpeta Mobile 
Favorites (Favoritos móviles) en el ordenador se sincroniza con Internet 
Explorer Mobile en el dispositivo. El ordenador y el dispositivo se actualizan 
con los cambios realizados en cada lista cada vez que se realice la 
sincronización. A menos que marque el vínculo favorito como si fuera un 
favorito móvil, sólo se descargará el vínculo en el dispositivo; para ver el 
contenido, deberá conectarse al ISP o a la red. Para obtener más información 
sobre la sincronización, consulte la Ayuda de ActiveSync en el ordenador.

Exploración de los favoritos móviles y de la web
Puede utilizar Internet Explorer Mobile para explorar los favoritos móviles 
y los canales descargados en el dispositivo sin necesidad de conectarse a 
Internet. También puede conectarse a Internet a través de un ISP o una 
conexión de red y navegar por la web.

Icono de favoritos
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Para ver los favoritos móviles y los canales:

1 Puntee en el icono de favoritos para mostrar la lista de favoritos. 

2 Puntee en la página que desea ver. 

Aparece la página que se descargó la última vez que realizó una 
sincronización con el ordenador. Si la página no está en el dispositivo, el 
favorito se muestra atenuado. Deberá volver a sincronizarse con el 
ordenador para descargar la página en el dispositivo, o bien conectarse a 
Internet para poder verla.

Para navegar por Internet, establezca una conexión con el ISP o la red 
corporativa mediante Conexiones, tal como se describe en el apartado 
“Cómo conectarse” en la página 95.

 NOTA: Para agregar un vínculo favorito, vaya a la página que desee agregar, 
puntee y mantenga el lápiz en la página y, a continuación, puntee en Add to 

Favorites (Agregar a favoritos).

Para conectarse a y explorar Internet, puede:

• Puntear el icono Favorites (Favoritos) y puntear el favorito que desea 
ver.

• En el campo de dirección que aparece en la parte superior de la 
pantalla de Internet Explorer, introduzca la dirección web que desee y 
puntee el icono de la derecha, o la flecha abajo para seleccionar las 
direcciones introducidas previamente.
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Mantenimiento y solución de 

problemas

Mantenimiento de Axim
Para dirigir el mantenimiento periódico del dispositivo, utilice la utilidad de 
autodiagnósticos de Dell Axim disponible en el CD de inicio. Esta utilidad 
de diagnóstico prueba muchas funciones del dispositivo: botones, versión 
del sistema operativo, estado de la batería, reproducción del vídeo, LED, 
controlador, modo de duplicación, Bluetooth, Inalámbrico y prueba de 
enlace del USB.

Instalación de la utilidad de diagnósticos

Para instalar la utilidad:

1 Cree una conexión de ActiveSync entre el dispositivo y el ordenador. 

2 Inserte el CD de inicio en la unidad de CD-ROM del ordenador. 

3 Haga clic en Getting Started→ Enhance Your Experience→ Tools 
(Inicio→ Experiencia más completa→ Herramientas). 

4 En el menú de selección de herramientas, seleccione Pocket PC 
Applications (Aplicaciones de Pocket PC). 

5 Desplácese por la lista hasta que vea Dell Axim X51/X51v Self-Diagnostic 
Utility (Utilidad de autodiagnóstico de Axim X51/X51v de Dell). 

6 Haga clic en Details→ Install (Detalles→ Instalar). 
7 Siga las instrucciones de la pantalla para instalar la utilidad de 

autodiagnóstico.

Para ejecutar un diagnóstico, puntee en Inicio→ Programas→ Axim Self-
Diagnostics (Autodiagnósticos de Axim).
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Solución de problemas
En la tabla siguiente aparecen algunos problemas habituales a los que se 
debe enfrentar y sus posibles soluciones. Para solucionar los problemas, 
utilice una solución única de la lista con viñetas o una combinación de 
soluciones en el orden dado.

Para obtener información acerca del restablecimiento ordenado o del 
restablecimiento forzado, consulte el apartado “Restablecimiento del PDA 
Axim” en la página 53.

Problema Solución

El dispositivo no ha detectado ningún 
accesorio con factor de forma como 
Compact Flash II o Secure Digital 
Card.

• Retire la tarjeta de la ranura y realice 
un restablecimiento ordenado del 
dispositivo.

• Si la tarjeta no se detecta ni tras 
realizar un restablecimiento ordenado 
del dispositivo, retire la tarjeta de la 
ranura y realice un restablecimiento 
forzado del dispositivo.

• Algunas tarjetas requieren su propio 
software. Si es necesario, instale el 
software.

El sistema no responde a los punteos 
en la pantalla 

• Limpie la pantalla táctil.
• Compruebe el seguro del botón a la 
izquierdadel sistema.

• Limpie la pantalla táctil.
• Realice un restablecimiento ordenado 
del dispositivo.

El sistema no responde a los comandos 
del botón 

• Compruebe el seguro del botón a la 
izquierdadel sistema.

• Puntee en Unlock (Desbloquear) en la 
pantalla Today (Hoy) si está en estado 
de bloqueo.

• Compruebe la configuración de 
asignación del botón.

• Realice un restablecimiento ordenado 
del dispositivo. 
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El dispositivo provoca un error de 
memoria 

• Ejecute los autodiagnósticos del 
dispositivo.

• Realice un restablecimiento ordenado 
del dispositivo. 

• Realice un restablecimiento forzado 
del dispositivo, pero no borre los datos.

• Realice un restablecimiento forzado 
del dispositivo y borre los datos.

El teclado de Bluetooth no funciona • Mantenga presionado CTRL Izq. FN 
Izq. FN Der durante unos 3 o 5 
segundos. 

• Realice un restablecimiento ordenado 
del dispositivo y, a continuación: 
• Puntee en Inicio→ Configuración→ 
Dell Axim Executive Keyboard 
(Teclado ejecutivo de Dell Axim)

• Puntee en Enable (Activar) y vuelva 
a intentar configurar el teclado

• Sustituya las pilas del teclado.
• Realice un restablecimiento forzado del 
dispositivo y, a continuación, vuelva a 
instalar el controlador del teclado. 

La unidad GPS no se muestra en el 
Bluetooth Manager (Administrador 
Bluetooth) después de una nueva 
búsqueda 

Haga clic en New Partnership (Nueva 
asociación) para iniciar una nueva 
búsqueda de dispositivos. 

No se recibe ninguna señal GPS si se 
sitúa en el panel de instrumentos 

Muchos nuevos coches de VW, BMW y 
Mercedes tienen un filtro metálico UV 
en la ventana delantera, para evitar las 
señales GPS. Intente colocar la unidad 
GPS cerca de la ventana trasera. 

Problema Solución
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Para obtener más información sobre la solución de problemas, consulte el 
manual que se incluye en el CD que se suministra con el teclado.

Se está esperando la señal GPS o no se 
recibe información GPS en la ventana 
de estado de GPS

• Apague y vuelva a encender la unidad 
GPS. 

• Compruebe la conexión del puerto 
serie en Bluetooth Manager 
(Administrador Bluetooth). 

• Utilice Auto Detect (Detección 
automática) en el software de 
navegación para encontrar el puerto 
COM correcto y la velocidad en 
baudios. 

• Compruebe la ubicación de la unidad 
GPS - La parte superior de la unidad 
debe poder “ver” el cielo.

Solución de problemas de Microsoft 
ActiveSync con los dispositivos de 
bolsillo Dell Axim

Para ver la Ayuda de Microsoft 
ActiveSync en el ordenador, inicie 
Microsoft ActiveSync y haga clic en 
Ayuda→ Microsoft ActiveSync.

Para obtener más información sobre la 
solución de problemas de Microsoft 
ActiveSync, consulte la página 
http://www.microsoft.com/windowsmobile/
help/activesync/default.mspx

Problema Solución
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Advertencia de seguridad sobre la descarga de 
archivos
Aparecerá el siguiente mensaje de advertencia de descarga de archivos al 
tratar de instalar los programas de software en el sistema Dell que ejecuta 
Microsoft® Windows® XP Service Pack 2 (SP2).

Como precaución de seguridad, la advertencia de seguridad sobre la 
descarga de archivos aparecerá en cualquier momento que se intente 
instalar un programa de software en el sistema. Es algo que ocurrirá a 
pesar de la procedencia del software que está intentado instalar.

 NOTA: Esta advertencia no indica que exista un problema con el sistema Dell.
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Apéndice

Especificaciones

Información del 
sistema

Procesador

Alta Procesador Intel® XScale™ PXA270 a 
una velocidad máxima de 624 MHz

Media Procesador Intel® XScale™ PXA270 a 
una velocidad máxima de 520 MHz

Baja Procesador Intel® XScale™ PXA270 a 
una velocidad máxima de 416 MHz

Memoria

Alta ROM Flash NAND de 64 MB/256 MB

Media ROM Flash NAND de 64 MB/128 MB

Baja ROM Flash NAND de 64 MB/128 MB

Sistema operativo Software Microsoft® Windows Mobile™ 
Versión 5.0 para Pocket PC Premium Edition 

Pantalla

Tipo Pantalla táctil transflectiva TFT VGA, QVGA 
en color de 16 bits

Tamaño

Alta 3,7 pulgadas (VGA)

Media 3,5 pulgadas (TFT QVGA)

Baja 3,5 pulgadas (TFT QVGA)

Resolución 240 x 320 a 65.536 colores (QVGA)

480 x 640 a 65.536 colores (VGA)

Brillo de LCD QVGA:100 nits

VGA: 100 nits
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Controles y luces

Navegación Botón de navegación de 5 vías

Botones Cuatro botones de programa: Calendario, 
Contactos, Mensajería y Página principal

Encendido/apagado

Botón de encendido/apagado para la 
tecnología inalámbrica WLAN/Bluetooth®

Botón de grabación de voz

Botón de restablecimiento

Botón de bloqueo

Indicadores Sincronización/comunicación

Notificación de eventos

Estado de carga

Ranuras de expansión

Tarjeta de memoria Secure Digital Una ranura para tarjeta de memoria Secure 
Digital (3,3 v) compatible con tarjetas SDIO de 
1 bit y 4 bits

Tarjeta CompactFlash Una ranura para tarjeta CompactFlash Tipo II 
(3.3v)

Puertos y conectores

Infrarrojos Estándar v1.2 (115 kbps)

Conector de sincronización/base Conector de 36 patas

Audio Auricular estéreo con conector compatible 
con micrófono monoaural
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Aspectos físicos

Dimensiones:

Longitud 119 mm (4,69 pulgadas)

Anchura 73 mm (2,87 pulgadas)

Altura 16,9 mm (0,67 pulgadas)

Peso

NOTA: El peso descrito 
hace referencia al 
dispositivo, sin incluir la 
tarjeta CompactFlash ni la 
tarjeta de memoria Secure 
Digital.

Alta VGA de 175 g (6,2 onzas) con 
batería estándar

Media VGA de 167 g (5,9 onzas) con 
batería estándar

Baja VGA de 167 g (5,9 onzas) con 
batería estándar

Audio

Controladora de audio Chip de sonido WM8750L

Conversión estereofónica Estéreo de 16 bits; frecuencia de muestreo de 8,0, 
11,025, 22,05 y 44,1 KHz

Grabación Grabación y reproducción full dúplex

Micrófono/altavoz Integrado

Auriculares Conector estéreo

Gráficos

Alta Marathon
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Conectividad inalámbrica

 WLAN (802.11b) Alta 802.11b

Media 802.11b

Baja Sólo tarjeta SDIO (CF no compatible)

Estándar de red IEEE 802.11b

Velocidad de datos 1 Mbps, 2 Mbps, 5,5 Mbps, 11 Mbps

Modulación CCK (11 Mbps, 5,5 Mbps); 
DQPSK (2 Mbps); DBSPK (1 Mbps)

Arquitectura de red ad-hoc e infraestructura

Frecuencias operativas 2,4–2,497 GHz

Canales operativos 1–11 (Norteamérica); 
1–13 (Europa y Japón)

Potencia de salida RF 13,0 dBm máximo

Alcance interior — hasta 10 m (120 pies) a 
5 Mbps y 75 m a 0,5 Mbps

Utilidad de cliente Perfil de ubicación automática, 
reconocimiento de emplazamiento, 
diagnósticos, estado actual del vínculo, 
ping

Asistencia de software Con certificado Wi-Fi

Indicadores Verde (estado de la WLAN)

Azul (estado de la tecnología inalámbrica 
Bluetooth)

Conmutador Encendido/apagado de radio manual 
(botón de hardware y conmutador de 
software) para cumplir con las 
restricciones aéreas

Tecnología inalámbrica 
Bluetooth

Funcionamiento de banda ISM a 2,4 
GHz; tecnología inalámbrica Bluetooth 
1.2 compatible; incluye administrador 
para Bluetooth con tecnología 
inalámbrica; dispositivo de Clase II; 
potencia máxima de salida de 4 dBm; 
funcionamiento a 3,3 V; interfaz UART
134 Apéndice



Suministro de energía

Tipos de batería:

Principal Batería recargable y extraíble de ion de 
litio de 1100-mAh (estándar)

Batería recargable y extraíble de ión de 
litio de 2200 mAh (opcional)

Copia de seguridad Condensador para conservar los datos 
RTC

Adaptador de CA:

Voltaje de alimentación 100–-240 V CA

Frequency 50–60 Hz

Consumo eléctrico 0,4 A

Voltaje de salida 5,4 V CC

Intensidad de salida 2,41 A

Aspectos ambientales

Intervalo de temperatura:

En funcionamiento De 0 °C a 40 °C (de 32 °F a 104 °F)

En almacenamiento De -20° a 60 °C (de -4° a 140 °F)

Gradiente de temperatura:

En funcionamiento Máximo 15°C (59°F) por hora

En almacenamiento Máximo 20 °C (68 °F) por hora

Humedad relativa (máxima):

En funcionamiento Del 10% al 90% sin condensación

En almacenamiento De 5% a 95% sin condensación
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Altitud (máxima):

En funcionamiento De 0 a 3.048 m

En almacenamiento De 0 a 12.190 m

Impacto máximo (medido con un pulso 
de media onda sinusoidal durante 2 ms):

En funcionamiento 200 G

En almacenamiento 400 G

Vibración máxima (utilizando un 
espectro de vibración aleatoria que 
simula el entorno del usuario):

En funcionamiento 2,6 GRMS

En almacenamiento 3,41 GRMS

Aspectos ambientales (continuación)
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Glosario
802.11 (W IF I):  Estándar de tecnología inalámbrica para dispositivos de red de medio 
alcance que permite que los dispositivos activados se reconozcan automáticamente.

BASE :  Dispositivo que permite al dispositivo de bolsillo sincronizarse con un 
ordenador, recargar la batería y funcionar con alimentación de CA.

CABLE  DE  SINCRONIZAC IÓN :  Cable que conecta un dispositivo de bolsillo a un 
ordenador para transferir o sincronizar archivos.

CONECTOR  SER IE :  Puerto de E/S que suele utilizarse para conectar dispositivos, 
como un dispositivo digital de bolsillo o una cámara digital, al ordenador.

DHCP:  Protocolo de comunicación que permite a los administradores de la red 
administrar y automatizar la asignación de direcciones de protocolo Internet a los 
ordenadores de una red.

IMAP (PROTOCOLO  DE  ACCESO  A  MENSAJES  DE  INTERNET ) :  Protocolo de 
acceso a mensajes de Internet: un protocolo convencional cliente/servidor que le 
permite acceder al correo electrónico desde su dispositivo. Con IMAP, puede 
almacenar y consultar su correo electrónico en el servidor ISP.

ISP (PROVEEDOR  DE  SERV IC IOS  DE  INTERNET ) :  Empresa que proporciona 
acceso al servidor host para conectarse directamente a Internet, enviar y recibir 
mensajes de correo electrónico, y acceder a sitios web. Generalmente, el ISP le 
proporciona un paquete de software, un nombre de usuario y números de acceso 
telefónico a cambio de una cuota.

LAN:  Red de ordenadores que abarca un área pequeña. Habitualmente una LAN 
comprende un edificio o unos cuantos edificios próximos entre sí. Una red LAN 
puede conectarse a otra LAN situada a cualquier distancia a través de líneas 
telefónicas y ondas de radio para formar una red de área extensa (WAN).

PIM (ADMINISTRADOR  DE  INFORMACIÓN  PERSONAL ) :  Programa que almacena y 
organiza la información personal tal como las aplicaciones Calendario, Contactos, 
Messaging (Mensajería) y Tareas.

POP3 (PROTOCOLO  DE  OF IC INA  POSTAL  3 ) :  Protocolo de oficina postal 3: 
protocolo convencional de cliente/servidor que le permite acceder al correo 
electrónico en el servidor ISP. Si utiliza POP3, debe descargar el correo electrónico 
a su dispositivo para ver y analizar sus mensajes.

RAM: memoria de acceso aleatorio: Área principal de almacenamiento temporal para 
datos e instrucciones de programas. La información almacenada en la RAM se pierde 
cuando se realiza un restablecimiento.

RAS (SERV IDOR  DE  ACCESO  REMOTO ) :  Tipo de servidor que permite a los 
usuarios acceder a una red desde una ubicación remota.

ROM: Memoria que almacena datos y programas que el dispositivo no puede borrar, 
y en los que no puede escribir. La ROM, a diferencia de la RAM, conserva el contenido 
después de realizar un restablecimiento. Algunos programas esenciales para la 
operación del dispositivo residen en la ROM.
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SDRAM: Tipo de DRAM sincronizada con la velocidad del reloj óptima del 
microprocesador.

SENSOR  DE  INFRARROJOS :  Puerto que permite la transmisión de datos entre el 
ordenador y los dispositivos compatibles con infrarrojos sin utilizar una conexión 
de cable.

S INCRONIZAC IÓN :  Proceso automatizado que reemplaza los archivos de una 
ubicación por archivos más actualizados de otra ubicación. Por ejemplo, puede 
sincronizar los archivos del ordenador con los archivos del dispositivo de bolsillo.

SMS (SERV IC IO  DE  MENSAJES  CORTOS ) :  Servicio capaz de enviar mensajes 
cortos a dispositivos inalámbricos.

SMTP (PROTOCOLO  SIMPLE  DE  TRANSFERENCIA  DE  CORREO ) :  Tipo de 
protocolo utilizado para enviar y recibir mensajes de correo electrónico. 
Normalmente, SNMP se utiliza conjuntamente con POP3 o IMAP.

TARJETA  COMPACTFLASH :  Tarjeta extraíble que sirve para expandir las 
capacidades de un dispositivo. Las tarjetas inalámbricas y las tarjetas de memoria son 
tipos comunes de tarjetas CompactFlash.

TARJETA  DE  MEMORIA  SECURE  D IG ITAL :  Tipo de memoria extraíble que suele 
utilizarse en cámaras digitales, dispositivos de bolsillo, teléfonos móviles y otros 
dispositivos. Las tarjetas de memoria Secure Digital tienen un tamaño similar al de 
un sello de correos.

TCP/IP (PROTOCOLO DE CONTROL DE TRANSMISIÓN/PROTOCOLO INTERNET): Lenguaje 
de comunicación básico de Internet. También puede utilizar TCP/IP como 
protocolo de comunicación en una intranet o extranet.

TECNOLOGÍA  INALÁMBRICA  BLUETOOTH
®:  Tecnología inalámbrica estándar para 

dispositivos de red de corto alcance (10 m [30 pies]) que permite que los dispositivos 
habilitados se reconozcan automáticamente entre ellos.

USB:  Interfaz de hardware para dispositivos de baja velocidad como un teclado, un 
ratón, una palanca de mando, un escáner, un juego de altavoces, una impresora, 
dispositivos de banda ancha (ADSL y módems por cable), dispositivos de imágenes y 
dispositivos de almacenamiento, todos ellos compatibles con USB. Los dispositivos 
se enchufan directamente en un enchufe de 4 patas situado en el ordenador o en un 
concentrador de varios puertos que se conecta al ordenador. Los dispositivos USB se 
pueden conectar y desconectar mientas el ordenador esté encendido, y también se 
pueden conectar en frecuencia.

VPN (RED  PRIVADA  VIRTUAL ) :  Conjunto de protocolos de comunicación que 
permite a los usuarios remotos acceder de manera segura a una red.

WAP (PROTOCOLO  DE  APL ICAC IONES  INALÁMBRICAS ) :  Estandarización de la 
forma en que los dispositivos inalámbricos acceden a Internet.
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